DILIGENT

ProtecTIER for the REO® 9500D

User Guide and Reference
Version 1.2

10400176-101

200 Crossing Boulevard | Framingham, Massachusetts 01702

508.663.1300  508.663.1399 fax | www.diligent.com

Oracle Ex. 1226, pg. 1
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
ProtecTIER

Documentation Copyright Information
25 March 2008
Copyright 2005 Diligent Technologies Corporation. All rights reserved.

No part of this publication may be reproduced or distributed in any form or by any means, or stored
in a database or retrieval system, without the prior written consent of Diligent Technologies.

The information contained in this publication is subject to change without notice. Diligent
Technologies assumes no responsibility for any errors that may appear.

This publication and (except as expressly agreed in a separate writing signed by Diligent
Technologies) the products described herein are provided “as is.” Diligent Technologies makes no
expressed or implied warranties in this publication relating to the use or operation of the products
described herein. DILIGENT TECHNOLOGIES EXPRESSLY DISCLAIMS THE IMPLIED
WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT AND FITNESS FOR A
PARTICULAR PURPOSE. In no event shall Diligent Technologies be liable for any indirect, special,
consequential, punitive or incidental damages arising out of or associated with any aspect of this
publication or the products described herein, even if advised of the possibility of such damages.

Product Copyright Information
Copyright 2005 Diligent Technologies Corporation. All rights reserved.

This software is furnished under a license and may be used and copied only in accordance with the
terms of such license and with the inclusion of the above copyright notice. This software or any other
copies thereof may not be provided or otherwise made available to any other person.

No title to and ownership of the software is hereby transferred.

The information in this software is subject to change without notice and should not be construed as a
commitment by Diligent Technologies.

LZO0 is included with the software package. LZO is Copyright (C) 1996, 1997, 1998, 1999, 2000
Markus Franz Xaver Johannes Oberhumer. LZO is distributed under the terms of the GNU General
Public License (GPL). The text of this license can be viewed at this URL:
http://www.gnu.org/copyleft/gpl.html#SEC1

Trademark Information

Diligent Technologies logo, VI'F, ProtecTIER and HyperFactor are trademarks of Diligent
Technologies Corporation.

Symmetrix, CLARiiON and EDM are registered trademarks of EMC Corporation. Solaris and Java
are registered trademarks of Sun Microsystems. Red Hat is a registered trademark of Red Hat Inc.
DLT 7000 and ATL P3000 are registered trademarks of Quantum Corporation. Windows is a
registered trademark of Microsoft. Emulex LightPulse HBA is a registered trademark of the Emulex
Corporation. Galaxy is a registered trademark of CommVault Systems Inc. Time Navigator is a
registered trademark of Atempo Inc. InstallAnywhere is a registered trademark of Zero G Software
Inc. All other trademarks are the property of their respective owners.

Overland products are covered by one or more of the following patents registered with the USPTO: 5,870,245; 6,328,766, 6,353,581;
6,496,325,

Overland®, Overland Storage®, LoaderXpress®, Multi-SitePAC®, NEO SERIES®, PowerLoader®, Protection 0S®, REO®, REO
SERIES®, VR2®, WebTLC®, and XchangeNOW® are registered trademarks of Overland Storage, Inc.

ARCvault™, NEO™, Simply Protected™, Simply Protected Storage™, SnapWrite™, ULTAMUS™ and ULTAMUS SERIES™ are
trademarks of Overland Storage, Inc.

© 2006-2008 Overland Storage, Inc. All rights reserved.

Oracle Ex. 1226, pg. 2
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies

User Guide and Reference

Contents

Chapter 1 - Introduction
About ProtecTIER ...t
HyperFactor. ..o
Performance and data availability........cccccceerieievierencincinnnn.
P ANSPATEIICY . eveaerreeeereeeesireeesereaeseaeesaseeesneassssnesesneesesans e sanees
Supported backup applications ........cccccevvvrrirrereriereseseerenenns

Best practice for off-site tape storage........ccccovveviivieeeciieiennenn.

Chapter 2 - Installing ProtecTIER Manager

ProtecTIER Manager requirements..........ccccerevevreeiiscinsneensnanns 272
Installing ProtecTITER Manager ......c..ccovevevionreeesnieessssnssnnnenns 2-3
Invoking ProtecTIER Manager.......c..coccceceveveenenesrnveessssessssnes 225

Uninstalling ProtecTIER Manager .........cccceovveievieeesnnecinnenns
Chapter 3 - Working with ProtecTIER Manager

2-6

O RV BT o cmcn s e s B S U N B S S e 3-2
Using the ProtecTIER Manager interface .........ccccocvveciiennen. 3-4
The ProtecTIER Manager display ........ccccevveeviieiieeniinieenneens 3-5
ProtecTIER Manager menu options..........ccccerevvneeecnrcisenennnanns 3-7
Using ProtecTIER wizards .........c.ccooeeeveericninnnneseasensesesnsnnaes 3-13
Chapter 4 - Monitoring ProtecTIER
Overview of ProtecTIER user activities........cccocevvieeercvennnnen. 4-2
LOgEING 1N ittt re e e ene e e e eanes 4-3
Monitoring an appliancCe .....c.ccovveeieeeeeririeeerearreeeee s ee e 4-5
Displaying ProtecTIER license information ..........ccccceveuennene. 4-9
Monitoring a repository......cccceveeviriieeienriie e ereareeeersnaneeeans 4-11
Monitoring & HDIary ......ccoceeevceveesee e esisessesseesssseesssesssnns 4-14
Monitoring the components of a library......ccccceeevivivinieeennns 4-16

Contents i

Oracle Ex. 1226, pg. 3
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies

ProtecTIER

iv. Contents

Chapter 5 - Operating ProtecTIER

Overview of operator activities .........cccvvevveiniiviniiieceireinineenn. 5-2
Managing tape drives and robots.........ccoccoviiiiiiiiinciiieee 5-3
AN AT IND C ATt T R i o e o R R S eSS4 5-5
Chapter 6 - Administering ProtecTIER
Overview of administrator activities ........c.cccceereiiivceiencnnnene. 6-2
Initial system onBgUrALION . cssmimsamsnmiars s 6-4
Modifying the configuration........cccccveverericniiececiineneccerineen 6-5
Chapter 7 - Managing appliances
Getting Started.......cccvveeericree e cerer s sn e rne s 7-2
Auto-discovery of appliances........cccceevieeiiienieiie e 7-3
ProtecTIER Manager update settings........ccocoeeveeeniiiiiennennnnn 7-4
Providing connection properties for an appliance...................7-5
Editing or viewing connection properties..........ccccovvveervvveernnnns 7-6
Removing connection to an appliance.........cccceeveevieiveveceennnnne. 7-7
Logging in to an appliance ........cceceevveeeeeerreessseeeeenieseee e 7-8
Logging out from an appliance........ccccovvveeveiieinvicneceeeeee 7-9
Managing the appliance front-end config..........ccccovvveeenenns 7-10
Managing the appliance ports attributes config...................7-13
Managing the ProtecTIER trace.......ccccocovvviceneceiinceinsecnenns 7-19
Creating a Service TePOTt.......cccceviiriirrerisssrrnresressssnsssssssssnsennes 7-21
Saving performance hiStory ........ccocevveeiieniiieeineieeeeenns 7-23
Updating ProtecTIER ......oiiivaniniiibaivinmmiitimivmnni =24
Chapter 8 - Monitoring repositories
L T T 8-2

Monitoring fragmentation in a repository..........cccceeeveeenennnn

Chapter 9 - Managing libraries

DT BTV TE o n e s oot 45508 K AN S b S A5 9-2
Displaying the library configuration .........ccccoeeviiiiveeinnnnnene. 9-3
e A A T I P BTN vy svinsiossss s fassmms i3 SR RV B oM TR 9-7
Changing the library configuration .........ccooceeeeiieiicciinnccnennes 9-11
Re-assigning robots and drives to ports ........cceecveeveveenenennes 9-15
Deleting a lIbrary.......ccocoeieieciiiee et 9-18
Adding cartridges to a library.......cccccceevevieenceiiinecneeeee 9-19
Checking a lIBrary ....cocoveieieeiiiiiee e rn e aes 9-22
Resetting the 10bot ...oooovviee e 9-24

Oracle Ex. 1226, pg. 4
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
User Guide and Reference

Chapter 10 - Managing library components

L) T [0 5

Displaying tape drives......cccccociierririciccn e 10-3
Performing tape drive actions.........ccecveevereciesieenenecvceesnennns 10-5
BHsplaying slots....camunanimneimmnminisia s 10-7
Performing glot actions ... cvnmniminmaimissnmii 10-9
Displaying import/export slots .....cinaniuianii 10-11
Performing import/export slot actions........ccccoeevveereenneen. 10-12
Displaying cartridges........ccvveevvenrirerrssrnrersremrsseesssssssssessnns 10-14
Performing cartridge actions.......c.cccoceveveiivnieercceircceen e 10-15

Chapter 11 - Recovering ProtecTIER

Performing recovery operations.........ccccccevvreeeereeircecenceneens 11-2

Chapter 12 - Manager Logs & Troubleshooting

ProtecTIER Manager user files.........cccceveieniecnnvicnneeenanne 12-2
Testing and troubleshooting........c.cocveviieiiiiiiin e 12-3
Chapter 13 - ProtecTIER logs
Displaying the Event 1og ........c.cccceeieviniivininnenieiciicceene 13-2
Events that are logged.........ccooveiieviiniiiene e 13-3
Displaying the Error log......ccccceeviveiieiiiieieiesiensnesinesieesne e 13-4
Errors that-are logged ... 13-5
Appendix A - Error messages
ProtecTIER Manager error messages......ccueveeereveeereeeensvesenans 14-2
Sense key information ........ccccooeeeiriiiniin e 14-3
Event 1og messages.....ccco oo vvveiiieieiiie e e senens e nn e e 14-6
Error 10g MeSSAges....ccoveviereeeceieee e e s e e e e 14-13

Appendix B - Glossary of terms
ETREE BRI cnnussis s s S e A A R S R 15-2

Appendix C - Obtaining customer support

Providing site information.........cccceiveeieenieiniiece e 16-2
Providing problem information.........cceccevveineeeveceieieieesnennns 16-3
Contacting the customer support center ........c.cocveeeeveervveeenns 16-4

Contents Vv

Oracle Ex. 1226, pg. 5
Oracle, et al. vs. Crossroads
IPR2014-01207



ProtecTIER

vi Contents

Oracle Ex. 1226, pg. 6
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
User Guide and Reference

Preface

This guide describes how to use ProtecTIER™ - the software
component of the REO 9500D appliance.

This guide is intended for user-site personnel filling the three
types of user roles:

ProtecTIER user A user who has been assigned this role
can monitor the activity of the appliance, its connections and

its VTLU libraries.

ProtecTIER operator A user who has been assigned this
role can perform all the functions of the ProtecTIER user, and
can also perform routine library management operations.

ProtecTIER administrator A user who has been
assigned this role can perform all the functions of an operator,
and can also perform these administration tasks: configuring
libraries, adding storage to a library, assigning LUNSs to front-
end ports.

For version-specific information on product features, see the
product Release Notes.

This preface describes the contents of the manual, lists the
manuals provided with the product, and tells how you can
contact Overland Storage for information.

Preface vii
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Manual contents

This manual contains a guide to ProtecTIER, a guide to using the
ProtecTIER client to access the REO 9500D appliances, and an appendix.

PART ONE - ProtecTIER Guide

Chapter 1, Introduction

Describes ProtecTIER and how it achieves high performance
and transparency.

Chapter 2, Installing ProtecTIER Manager

Describes how to install and invoke ProtecTIER Manager
from a workstation.

Also describes how to update and uninstall ProtecTIER
Manager.

Chapter 3, Working with ProtecTIER Manager

Describes how to use the ProtecTIER Manager display to access
information and invoke actions. Also contains a list of ProtecTIER
Manager menu options, and describes how to invoke ProtecTIER
Manager wizards for performing ProtecTIER administration tasks.

Chapter 4, Monitoring ProtecTIER

Provides an overview of activities performed by a ProtecTIER
user defined with the ProtecTIER user role.

Chapter 5, Operating ProtecTIER

Provides an overview of activities performed by a ProtecTIER
user defined with the ProtecTIER operator role.

Chapter 6, Administering ProtecTIER

Provides an overview of activities performed by a ProtecTIER
user defined with the administrator role.

viii Preface

Oracle Ex. 1226, pg. 8
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
User Guide and Reference

PART TWO - Using ProtecTIER

The ProtecTIER appliances at the site are accessed via the ProtecTIER
Manager client.

Chapter 7, Managing appliances

Describes how to connect to one or more ProtecTIER appliances, and how
to display the configuration of the appliance. Describes how to control
the appliances (restart, reboot, etc.).

Chapter 8, Monitoring repositories

Provides an understanding of the repository and how to monitor
fragmentation of the repository.

Chapter 9, Managing libraries

Describes how to dislpay the configuration of a library, its front-end port
configuration, performance parameters and robot information.
Describes how to access ProtecTIER Manager wizards to perform
administration tasks on the library: creating and adding a library to an
appliance, adding cartridges to a library, changing library dimensions
(number of drives and/or slots), attaching or detaching a library from the
appliance.

Chapter 10, Managing library components

Describes how to display information about the tape drives, internal
slots, import/export slots and cartridges in a library.

Also describes how to unload a tape drive, and move a cartridge from one
slot or drive to another.

Chapter 11, Recovering ProtecTIER

Describes the basic consistency check performed every time the system
comes up. If the system is found or suspected to be corrupt, you are
prompted to execute checks and recovery elements in respect to the
damage found.

PART THREE - ProtecTIER Mgr Administration

Chapter 12, Manager Logs & Troubleshooting

Describes how to dislpay and work with the warnings and error
messages that are written to a log file. There may be situations where
Technical Support requests that you examine this file, or forward it to
them.

Preface ix
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Chapter 13, ProtecTIER logs

Describes how to use the ProtecTIER Manager logs. As users work with
ProtecTIER via the ProtecTIER Manager client, events are logged.
These are not errors, but they can be used to understand what
ProtecTIER was doing when an error occurred.

APPENDIX

Appendix 14, Error messages
Lists error messages that might be issued by ProtecTIER.

Appendix 15, Glossary of terms

Provides terms and acronyms used to describe ProtecTIER.

Appendix 16, Obtaining customer support

Describes how to report software problems to Technical Support.

X Preface

Oracle Ex. 1226, pg. 10
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
User Guide and Reference

ProtecTIER documentation

ProtecTIER documentation set

A User Guide and Reference and Release Notes are supplied with
ProtecTIER.

User Guide and Reference

This guide describes how to monitor, manage and administer
ProtecTIER - the software component of the REO 9500D Appliance. The
guide is intended for user site personnel.

Tasks described here are performed when changes are made to the
library configuration, and during day-to-day operations.

Release Notes

The product release notes contain specifications that are applicable to
the current version of the product. They list new features, changes in
behavior, and limitations.

Preface xi
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Contact information

Sales and customer service contacts

For more information, or to reach Technical Support and Customer
Service, please contact Overland Storage:

Overland Storage
Worldwide
Headquarters

Sales

Technical Support

Overland Storage,
EMEA

Overland Storage, Inc.
4820 Overland Avenue
San Diego, CA 92123
Toll Free: (800) 729-8725
Tel: (858) 571-5555

Fax: (858) 571-0982

Tel: (858) 571-5555

Fax: (858) 571-3664

E-mail: sales@overlandstorage.com
http://www.overlandstorage.com

Tel: (858) 571-5555

Fax: (858) 495-4202

Toll Free: (877) 654-3429

International: +1 (858) 571-5555 Option 5
E-mail: techsupport@overlandstorage.com
http://support.overlandstorage.com

Overland House, Ashville Way
Wokingham, Berkshire
RG41 2PL, England

Tel: +44 (0) 118-9898000
Fax: +44 (0) 118-9891897
http://www.overlandstorage.com

Product registration

Do not forget to register your REO 9500D appliance on the Overland
Storage Customer Support Website. When you access the site, If you are
not yet a member, click the New member? link and follow the

instructions. It’s free!

Your comments

Your suggestions help us continue to improve the accuracy,
organization, and overall quality of user publications. Please e-mail us
at techsupport@overlandstorage.com with your feedback.

Xii Preface

Oracle Ex. 1226, pg. 12
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
User Guide and Reference

PART ONE - ProtecTIER Guide

These chapters describe ProtecTIER on the 9500D appliance.
They also describe the activities performed in monitoring,
operating, and administering ProtecTIER.

PART ONE - ProtecTIER Guide 1
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Introduction 1

This chapter provides an overview of Diligent Technologies
ProtecTIER.

Introduction 1-1
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About ProtecTIER

ProtecTIER virtualizes tape library units (TLUs). It emulates the tape drives, tape
cartridges and the library robotics that mount and dismount the cartridges in the tape
drives.

ProtecTIER software is installed on the REO 9500D. The REO 9500D is configured
as one or more Virtual Tape Libraries (VTLs). The backup application writes its
data directly to the VTLs on the REO 9500D.

A backup server connected to the REO 9500D appliance functions as though it is
operating a real TLU, while it is actually operating the REO 9500D appliance,
storing the tape data on the REO 9500Ds disk arrays.

Qf ﬁ
()
-

Backup Server

AL RRNRE
[l

REO 9500p0
Appliance

ProtecTIER integrates seamlessly into existing backup and recovery environments.
Integrating ProtecTIER VT is equivalent to installing a new tape library into an
existing backup and recovery environment.

ProtecTIER provides an enterprise-wide solution, helping IT managers consolidate
backup and recovery of data across the organization. ProtecTIER is designed to
provide scalability, flexibility, cost reduction due to significant reduction in amount
of archiving storage, high performance and transparency.

1-2 About ProtecTIER
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HyperFactor

ProtecTIER is the first virtual tape product to contain patent-pending data factoring
technology that Diligent calls HyperFactor™. This technology detects recurring
data in multiple backups. The common data is merged into a single instance store,
saving on disk space needed to store multiple backups without sacrificing
performance or the availability of backups for restore.

HyperFactor is a breakthrough on several fronts:

o scales up to a petabyte

o thealgorithm used to find the common data between backups does not affect the
backup performance of the virtual tape engine

o data integrity is not compromised, not even statistically

o merged data is stored in a format that preserves restore performance

HyperFactor saves space by taking advantage of the fact that only a very small

percentage of data actually changes from backup to backup. Incremental backups

include all files whose modification dates have changed since the last full or

incremental backup; and full backups backup all data, changed or not.

The amount of space saved is a function of many factors, but mostly of the backup

policies and retention periods and the variance of the data between them. The more

full backups retained on ProtecTIER, and the more intervening incremental

backups, the more space that will be saved overall.

Introduction 1-3
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Performance and data availability

As backup windows become smaller and downtime costs increase, backup and
recovery performance can be increased linearly by adding additional REO 9500D

appliances.

Backup Servers REO 95000 ProtecTIER
Appliances Manager

Fibre Channel

Multiple REO 9500D appliances are monitored, managed and administered from a
workstation via ProtecTIER Manager, the GUI client.

1-4 Performance and data availability
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Transparency

When a backup server connects via Fibre Channel to ProtecTIER, it views the
REO 9500D appliance as if it were TLU robotics and tape drives.

Emulated robotics

ProtecTIER identifies the emulated TLU robotics to the backup server as an ATL
P3000' TLU. A backup application running on the backup server operates the
library’s robot exactly as it would operate a real P3000 TLU.

Emulated tape drives

ProtecTIER identifies the emulated tape drives to the backup server as Quantum
DLT 70007 tape drives. A backup application running on the backup server writes
and reads the library’s tape drives exactly as it would write and read real DLT 7000
tape drives.

Front-end port assignments

ProtecTIER reports the assignment of emulated TLU robotics and emulated tape
drives to front-end FC ports in the same way that a real TLU would. It assigns
different SCSI LUN numbers to the robotics and to each tape drive.

The figure depicts a library with a robot and three tape drives, distributed over two
front-end ports.

ProtecTIER

Front-end Appliance

FC ports

=

LUN O

LUN 1

' ATL and P3000 are registered trademarks of Quantum Corporation.
4

DLT 7000 is a registered trademark of Quantum Corporation.

Introduction 1-5
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Supported backup applications

Leading industry backup applications are able to operate ATL P3000 TLUs and
Quantum DLT 7000s. Diligent has verified that the leading applications work
transparently with the emulated ATL P3000 and DLT 7000s implemented by
ProtecTIER.

For version-specific information, see the ProtecTIER Release Nofes.

1-6 Supported backup applications
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Best practice for off-site tape storage

ProtecTIER has the ability to store months of backup data on substantially less disk
space than any other "backup to disk" products, and most customers consider
ProtecTIER as an excellent platform for long-term data retention. Because
ProtecTIER typically manages large quantities of data, protection of the
ProtecTIER repository is an essential component of every ProtecTIER installation.

Diligent’s Best Practice recommendation for all ProtecTIER deployments is to
create offsite tape copies on a daily basis. This method ensures that all data within
ProtecTIER is protected. To adhere to this recommendation, the cloning or
duplication feature of the backup application is used for each backup job to create a
second copy of each backup image on tape. The tapes are collected and transported
to an offsite location on a daily basis. This process protects against disasters that
could simultaneously destroy the primary data sets and the backup data sets stored
on ProtecTIER, as well as operational or logical errors that could impact the
integrity of the ProtecTIER repository.

Introduction 1-7
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Installing ProtecTIER Manager| 2

ProtecTIER Manager provides a graphical client interface for users,
operators or administrators who will access the ProtecTIER appliances.

The ProtecTIER Manager can be installed and deployed on a
Windows, Solaris or Linux workstation. It is installed via an install
shield wizard.

ProtecTIER Manager requirements. . ..................... 2-2
Installing ProtecTIER Manager. . ........................ 2-3
Invoking ProtecTIER Manager.......................... 2-5
Uninstalling ProtecTIER Manager .. ..................... 2-6

Installing ProtecTIER Manager 2-1
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ProtecTIER Manager requirements

ProtecTIER Manager can be installed and deployed on a Windows, Solaris or Linux
workstation.

It can be installed on any computer on the network, as long as this computer can
identify the ProtecTIER appliances (the ProtecTIER Manager workstation and the
appliance should not be in different subnets separated by a firewall).

Operating system requirements

The following version of the operating system must be running on the workstation:
Windows Windows 2000, 2003, or XP

Solaris SUN Solaris 8 or higher

Linux Red Hat Enterprise 3 (32 bit) or higher

Disk space requirements
At least 100 MB available space.

Memory requirements
At least 256 MB.

Graphics card and monitor

On a UNIX system, you must configure the graphics card and the X windows
system. Refer to the Linux or Solaris documentation for instructions on configuring
the X manually, or via the Xconfigurator utility.

Display screen resolution requirements

Display properties of screens that will be used with ProtecTIER Manager must be
set as follows:

o screen area of at least 1024 by 768 pixels

o 24 bit colors or higher

2-2  ProtecTIER Manager requirements
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Installing ProtecTIER Manager

ProtecTIER Manager installation files are available on CD or from Diligent’s FTP
site.

To install ProtecTIER Manager, invoke and run the installation wizard.

If you have been running an older version of ProtecTIER Manager, uninstall the old
version before installing the new version. See Uninstalling ProtecTIER
Manager on page 2-6.

Extracting the files from the FTP site

If you get the files from the FTP site, you must extract the files as appropriate for
the operating system:

Windows

Double-click this file and unzip its contents, where <version number>is the version
number:

ProtecTIER Manager V<version number>.tar

Solaris or Linux
Issue this command where <version number> is the version number:

tar -oxvf ProtecTIER Manager V<version number>.tar

Identifying the files on the CD

On the CD, the installation files must be taken from the appropriate subdirectory:
ProtecTIER_Manager_V<version number=/Windows

ProtecTIER_Manager V<version number>/Solaris

ProtecTIER Manager V<version number>/Linux

Invoking the installation wizard

When you extract the files, three sub-directories are created: one for Windows, one
for Solaris, and one for Linux.

Invoke the installation wizard from the appropriate sub-directory for the target
operating system (Windows, Solaris or Linux).

Windows
Double-click on the file Windows\Install.exe.

Installing ProtecTIER Manager 2-3
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Solaris

The file Solaris/install.bin is provided. Invoke the installation wizard by issuing this
command:

sh <full path to Solaris/Install.bin>

Linux

The file Linux/install.bin is provided. Invoke the installation wizard by issuing this
command:

sh <full path to Linux/Install.bin>

Running the installation wizard

The ProtecTIER Manager installation wizard opens to guide you through the
installation. Enter the requested information in each dialog and click Next to
proceed to the next dialog.

Choose the install folder
Indicate where you would like to install ProtecTIER Manager.

Choose the shortcut location

Indicate where you would like to create application shortcuts/links.

2-4 Installing ProtecTIER Manager
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Invoking ProtecTIER Manager

Do not run more than one instance of ProtecTIER Manager, simultaneously, from a
particular directory, under the same network user name.

Invoke ProtecTIER Manager as appropriate for the operating system.

Windows

Invoke ProtecTIER Manager via the shortcut that was created during installation, or
from ProtecTIER_Manager.cxe in the installation directory.

Solaris or Linux

Invoke ProtecTIER Manager via the link that was created during installation, or
from the ProtecTIER Manager file in the installation directory.

Installing ProtecTIER Manager 2-5
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Uninstalling ProtecTIER Manager

If you have been running an older version of ProtecTIER Manager, you should
uninstall the old version before installing the new version.

The uninstall procedure is operating system dependent. Invoke the uninstaller as
described here, and follow the instructions provided by the wizard.

Windows
Invoke ProtecTIER Manager uninstaller in one of these ways:

o Run the Uninstall ProtecTIER Manager.exe file from the directory in which
ProtecTIER Manager was installed.

o Invoke the uninstaller from the shortcut. For example, if the ProtecTIER
Manager shortcut was installed in the default directory, invoke it as follows:

Start>Programs>DTC>ProtecTIER Manager>Uninstall ProtecTIER
Manager

Solaris
Invoke ProtecTIER Manager uninstaller in one of these ways:

o Run the Uninstall_ProtecTIER_Manager file from the directory in which
ProtecTIER Manager was installed.

o Invoke the uninstaller via the Uninstall ProtecTIER Manager link which was
created during installation.

Linux
Invoke ProtecTIER Manager uninstaller in one of these ways:

o Run the Uninstall_ProtecTIER Manager file from the directory in which
ProtecTIER Manager was installed.

o Invoke the uninstaller via the Uninstall ProtecTIER Manager link which was
created during installation.

2-6 Uninstalling ProtecTIER Manager
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Working with ProtecTIER Manager| 3

ProtecTIER Manager is the client used to access one or more
REO 9500D appliances at a user site.

This chapter describes how to use the ProtecTIER Manager display to
access information and perform actions. It describes how ProtecTIER
Manager wizards guide you in performing administration tasks.

See Chapter 2, Installing ProtecTIER Manager.

Chapter 13, ProtecTIER logs discusses the event log and the error

log.

Refer to the Release Notes for version-specific limitations of
ProtecTIER Manager.

OVEIVIEW . . oot e 372
Using the ProtecTIER Manager interface. . ................ 3-4
The ProtecTIER Manager display. . ...................... 3-5
ProtecTIER Manager menuoptions . ..................... 3-7
Using ProtecTIER wizards .. .......................... 3-13

Working with ProtecTIER Manager 3-1

Oracle Ex. 1226, pg. 29
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
ProtecTIER

Overview

The ProtecTIER Manager client is used to access the REO 9500D appliances at the
user site.

Backup Servers REO 9500p Appliances
ProtecTIER

Manager

Fiber Channel

/ TCP/IP

ProtecTIER Manager has three user types with three different authorization rights:

o ptuser for monitoring ProtecTIER

o ptoper for operating ProtecTIER

o ptadmin for administering ProtecTIER

For more information on logging in to an appliance, see Logging in to an
appliance on page 7-8.

Monitoring configuration and performance

When you log in to an appliance with a username that is only authorized to monitor
ProtecTIER, you can display the configuration of that appliance, the hyperfactor
and repository, and each VTLU library attached to it. You can display information
about the drives, slots and cartridges in each library.

3-2 Overview
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Operating ProtecTIER

If your username is authorized to operate ProtecTIER, in addition to vifuser rights,
you can set library HyperFactor mode, unload a drive, reset a drive or robot, set the
read/write state of a cartridge, and move a cartridge.

Administering ProtecTIER
If your username is authorized to administer ProtecTIER, in addition to vifoper
rights, you can invoke wizards to guide you in performing configuration operations:
o creating or deleting a library
o modifying the configuration of a library
o adding or deleting cartridges to a library

o performing an integrity check on the library and cartridges, if necessary
o configuring port type and mode

o dumping ProtecTIER trace

o restarting ProtecTIER service

o rebooting ProtecTIER appliance

Working with ProtecTIER Manager 3-3

Oracle Ex. 1226, pg. 31
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
ProtecTIER

Using the ProtecTIER Manager interface

ProtecTIER Manager presents a standard graphical user interface (GUI).

Invoking an action
Choose an action to perform in one of these ways:

o By choosing an option from a drop-down menu on the menu bar at the top of the
window.

o By clicking the equivalent icon on the toolbar under the menu bar.

o By choosing an option from a right-click menu. By right-clicking on an object
in the navigation pane or in the work pane, you can access a right-click menu
listing available actions. Right-click menus are context sensitive. The menu
lists actions that can be performed on the object that was clicked: appliance,
library, slot, etc. In general, an appliance’s right-click menu has options that
appear on the Appliance menu on the menu bar when that appliance is selected,
and a library’s right-click menu has options that appear on the Library menu on
the menu bar, when that library is selected.

Disabled actions

Actions may appear dimmed on menus, icons and buttons.

These are actions that are not appropriate for the current state of the system or the
display, for the selected object, or for the authorization level of the user who is
choosing an action to perform.

Tool tips

Tool tips appear describing the purpose of an object when the pointer is placed over
the object.

Hot keys and shortcut keys

You can use keyboard hot keys or shortcut keys to select menu options and buttons.

3-4 Using the ProtecTIER Manager interface
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The ProtecTIER Manager display

The ProtecTIER Manager display consists of a navigation pane on the left and a
work pane on the right.

[l ProtecTIER Manager
Ble  fApplance Rgpostory  ProbecTIER VT View  Recovery

Tocks  Help

EEX

E}: [2)  apphiance *‘J 5 '\i X:l r___{’ Library _:.lg-l...m-le,.-. t';—— (}‘: @

— ) 165.159.150.130
- N eimo.diigent. com

taz

= Appliance taz.diligent.com

f Reposkory Connected as user  Host Name | taz.diligent.com

] e Repostory Library front-end
Port | Top. | WwN

[Lun_ [ Device

[ System overview

@ 5ystem Onlre  Connected to taz.diligent.com as user

Front End Tab | Ports Attrbutes |

0 P2p 10000000c92b7ede

0 Drive 0
1 Drive 1
2 Drive 2
3 Drive 3
4 Drive 4
5 Drive 5
6 Drive 6
7 Drive 7
8 Drive 8
9 Drive 9
10 Drive 10
1 Drive 11
12 Drive 12
13 Drive 13
14 Drive 14
15 Drive 15
16 Drive 16
17 Drive 17
18 Drive 18
19 Drive 19
20 Drive 20

21 Drive 21

Navigation pane

The navigation pane contains a node for each ProtecTIER appliance for which
connection properties added manually have been provided, or which have been

auto-detected.

FE Ports
(=1 e : .
[WRead [ write ]
0.00 {ME/Sec) 0.0 (MBSec)
o (10f5%¢) © (10fSac)

295 /84

| Scale graph to

@System Online

| ¥ersian information
ProtecTIER Version 1.22

| Stiows fixes |

___ I

You can re-scan the network, at any time, to refresh the list of appliances listed in

the navigation pane.

If you have logged on to the appliance, you can expand the node to display the

repository node.

You can expand the repository node to display nodes representing its libraries.
You can expand a library node to display nodes representing its drives, slots,

import/export slots and its cartridges.

Working with ProtecTIER Manager 3-5
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Work pane
The work pane displays information about the component that is selected in the
navigation pane.

A status bar appears at the bottom of the work pane indicating that the appliance is
connected, the host name of the appliance, and whether or not the system is online.

[ Connected to nemo.diigent.com as operator | | @SystemCnine | | Durp trace || dhests |

The Dump trace button is used to create a new dump file of the ProtecTIER internal
| Dump trace ] trace. See Dump the ProtecTIER trace on page 7-20.

You can toggle the view of the Dump trace button. To view the Dump trace
button on the status bar:

1. Choose Tools>Preferences. The Preferences dialog is displayed.
2. Choose the View tab.

Preferences FZ|

Auto discovery ] Update settings | Logaging || Wigw ||

- View

[¥] Shows dump trace option on status bar

(5]

3. Select the checkbox to display the dump trace option on the status bar.
4. Click OK.
T If the Alerts button is flashing. messages have been added to the error log since the
erts ¥

last time it was cleared. Click this button to display the error log. See Displaying
the Error log on page 13-4.

3-6 The ProtecTIER Manager display
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ProtecTIER Manager menu options

These options are accessed via the menu bar at the top of the display, or via a right-
click menu, or via icons on the toolbar. Some of the options require operator or
administrator authorization.

File menu
icon option name function when enabled user role
= Exit log out from all appliances and exit always enabled all
from ProtecTIER Manager

Appliance menu

Some of these options are available from the right-click menu of an appliance, or on
the toolbar.

Some options are enabled only when a connected (logged in) appliance is selected
in the navigation pane. Others are enabled only when a disconnected (logged out)
appliance is selected.

icon option name function when enabled user role
Login log in to the appliance selected in  a disconnected all
the navigation pane appliance is selected
Logout log out from the selected appliance a connected appliance  all
is selected
Add appliance specify connection properties for an always enabled all

appliance and add it to the
navigation pane

R sl ol &

Connection edit or view the connection an appliance is selected all
properties properties of an appliance (edit - for a

disconnected appliance

only)
Remove removes appliance from the an appliance is selected all

appliance navigation pane

Reboot reboots ProtecTIER appliance a connected appliance  admin
appliance is selected

Working with ProtecTIER Manager 3-7
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icon option name function when enabled user role

Restart restarts ProtecTIER service a connected appliance  admin

ProtecTIER is selected

service

Dump trace dumps the program trace a connected appliance  operator
is selected

Reset trace resets the program trace a connected appliance  operator
is selected

Set trace levels modifics the tracing and logging  a connected appliance  admin

levels of the ProtecTIER appliance is selected

Create service generates a service prablem report  a connected appliance  all

report to send to Technical Support is selected

Save saves performance statistics of a connected appliance  admin

performance  ProtecTIER VT is selected

history

Port attributes invokes ports attribute wizard a connected appliance  admin
is selected

ProtecTIER checks if a patch exists, based on  a connected appliance admin

patch update  {he appliance’s ProtecTIER version is selected

check from Diligent’s FTP site

License displays ProtecTIER license a connected appliance all

information

is selected

ProtecTIER VT menu

ProtecTIER VT Library menu

Most of these options are available from the right-click menu of a library.

icon option name function when enabled user role
.r_, Create new invokes the Create new library  arepository is selected admin
{1579 library wizard to create a new library
Add cartridges invokes the Add cartridges wizard a library is selected admin
to add cartridges to an existing
library
Change invokes the Change dimensions a library is selected admin
dimensions wizard to change the number of
drives or slots in a library and port
assignments
3-8 ProtecTIER Manager menu options
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icon option name function when enabled user role
Re-assign invokes the Re-assign devices a library is selected admin
devices wizard to reassign robot and tape

devices to different front-end ports

Delete library invokes the Delete library wizard a library is selected admin
to delete a library and make the disk
space available

Rename library rename a library a library is selected admin

Check library invokes the Check library wizard a library is selected admin
to perform an integrity check on the

library
Reset robot perform a SCSI reset of the robot  a library is selected operator
Set library type set library inquiry fields a library is selected admin

ProtecTIER VT Drive menu

This option is also available from the right-click menu of a drive.

option name function when enabled user role
Load drive load a cartridge in a tape drive an online drive with operator
unloaded cartridge is
selected
Reset drive perform a SCSI reset of a tape drive a drive is selected operator

ProtecTIER VT Cartridge menu

This option is also available from the right-click menu of a cartridge.
You must unload a drive before you can move its cartridge.

option name function when enabled user role
Move move a cartridge from one drive or one or more cartridges operator
cartridges slot to another are selected in the

drives, slots, or imp/exp

views
Read/write toggle a cartridge between a cartridge in a slotis  operator
cartridge read/write and read-only selected
Rebarcode change the barcode of an existing  a cartridge in imp/exp admin

cartridge to a new barcode slot is selected

Working with ProtecTIER Manager 3-9
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option name function when enabled user role
Delete deletes a cartridge in cartridges view admin
cartridges

Check verifies cartridge data integrity a cartridge is selected  admin
cartridge

integrity

View menu

icon option name function when enabled user role
Refresh update the display to reflect the always enabled all

current status of the appliance
Refresh update tree structure in navigation  always enabled all
navigation pane to reflect current status
pane

3-10 ProtecTIER Manager menu options
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Recovery menu

icon option name function when enabled user role
System check performs a thorough check on always enabled admin
ProtecTIER components
Recover fixes problems that were found in  always enabled admin
cartridges the Cartridge manager during the
manager system check.

Tools menu

option name function when enabled user role
Update upgrades the ProtecTIER Manager always enabled admin

to the latest version fram Diligent’s

site
Preferences displays auto discoverv of always enabled all

appliances, update settings and
logging properties

View manager displays ProtecTIER Manager always enabled all
log history log

Import and always enabled all
Save History

File

Help menu

icon option name function when enabled user role
About display ProtecTIER version and always enabled all
copyright information

Working with ProtecTIER Manager 3-11
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Right-click menu
These options appear on the right-click menu invoked by right-clicking on the
navigation pane, not on a node in the tree.
icon option name function when enabled user role
Add appliance add connection properties for an always enabled all
appliance
Refresh update tree structure in navigation always enabled all
navigation pane to reflect current status
pane
Auto discovery re-scan the network to refresh the  always enabled all

navigation pane with appliances
found on the sub-nets

3-12 ProtecTIER Manager menu options
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Using ProtecTIER wizards

Wizards are invoked during ProtecTIER administration, to guide the administrator
in performing multi-step tasks that require user input.

Each ProtecTIER wizard window has the layout shown here.

earth. diligent.com : Greate new library

DILIGENT

Create new library

Library name ‘
« Welcome

Choose a name for this lbrary.
Library details

ProtecTIER ¥T name: F'lof‘:cltl |

Tape drives

Cartridges 3
Robot [

Report

Choose the port an which the backup application will view the rabat ‘

View r0bo From earth.digenk. com Robot part umber [1 [ =]

|4grev | Erish || Cancel |

Progress pane

The pane on the left displays the name of the wizard and lists the steps to be
performed.

The first step of each wizard is a welcome message that explains what the wizard
will accomplish.

The last step of each wizard presents a report summarizing the outcome of the
actions that will be performed when the Finish button is clicked.

The steps in the list are coded as follows:

« Completed step A step that has been completed has a check mark. Ifit is
underlined, it serves as a link to bring you back to that step.
Current step The step that is currently being performed is bold.

Pending step A step that you have not performed is not bold.

Dialog pane

The pane on the right provides instructions and explanations about the current step.
It displays fields in which you enter information needed to perform the step.

Working with ProtecTIER Manager 3-13
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Buttons

The bottom of the display contains navigation buttons. They are enabled only as
appropriate. For example, you cannot proceed to the next step if you have not
supplied required information to the current step.

Prev goes to the previous step
Next goes to the next step
Finish finishes the wizard when all mandatory steps have been performed

Cancel exits the wizard and cancels its action

3-14 Using ProtecTIER wizards
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Monitoring ProtecTIER

4

When you log in to an appliance as vtfuser, you can view the activity
of the ProtecTIER appliances, the HyperFactor and repositories, their
connections and their libraries during day-to-day operations of the
backup application.

The ProtecTIER Manager client guides you in the performance of
monitoring activities.

For an introduction to using ProtecTIER Manager, see Chapter 3,
Working with ProtecTIER Manager.

Overview of ProtecTIER user activities .. ................. 4-2
Loggingin...........oouuinoiii i 4-3
Monitoring anappliance . ........... ... ... ... ..., 4-5
Displaying ProtecTIER license information................ 4-9
Monitoring a repository. . ...t 4-11
Monitoringa library .. ...... ... ... ... ... ... ... ... ... 4-14
Monitoring the components of alibrary . ................. 4-16
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Overview of ProtecTIER user activities

Your job, as a ProtecTIER user, is to use the ProtecTIER Manager client to view the
various ProtecTIER appliances connected to the backup servers at your site, just as
you would monitor an actual tape-based backup system.

ProtecTIER user tasks are performed during day-to-day operations of the backup
application. You can only perform those tasks that are permitted to the role assigned
to your username.

You can log on to the ProtecTIER appliances at your site, and display the
configuration of each appliance and its VTLU libraries.

Messages may appear on the ProtecTIER Manager display, alerting you to warning
or error conditions. You must deal with these as appropriate, or notify the
ProtecTIER operator or administrator. See Appendix 14, Error messages.

4-2 Overview of ProtecTIER user activities
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Logging in

When you invoke ProtecTIER Manager, the ProtecTIER appliances that you can
monitor are listed in the navigation pane at the left of the display.

If you cannot access ProtecTIER manager, or if no appliances are listed, contact the
ProtecTIER operator for assistance.

[t ProtecTIER Manager

File Appliance Repository HyperFactor ProtecTIER VT  Yiew Recovery Tools Help

Ek @ Applance ] & _,\5 [l & | ubrary Q) cartridges G2 \-3: @

168.159.150.175

Bt ] @ Appliance earth.diligent.com

Foue.diigent.com Mot connected
mars. diigent. com
—Iig panter.diigent.com __Please take the following action:

=l

To connect to appliance, click on the Login button

Login to appliance ‘, Login

Logging in to an appliance

In order to view the configuration of an appliance, you must connect to the
appliance by logging in. You should log in to all the appliances you wish to monitor
in this session.

:ﬁ& 1. Select a disconnected appliance in the navigation pane.

I@ 2. Click the Login button to display the Login dialog.

Username: | |

Password: | l

[[] save password | ol | Cancel

3. Enter your ProtecTIER username and password.

4. Click Ok.

For user types and authorization rights, see Qverview on page 3-2.

Monitoring ProtecTIER 4-3
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Refreshing the display

When you log in to appliances, ProtecTIER interrogates the appliances and displays
the current configuration. A node for the repository is listed in the navigation pane
under the appliance node. Nodes for each library are listed in the navigation pane
under the repository node.

Subsequently, the performance values of the appliances are refreshed at appropriate
intervals.

— You can refresh a connected appliance’s configuration at any time by clicking on
l [UJ the Refresh button on the toolbar, when that appliance is selected in the navigation
pane.

4-4 Logging in
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Monitoring an appliance

For a detailed explanation of how to configure an appliance, see Managing the
appliance front-end config on page 7-10 and Managing the appliance
ports attributes config on page 7-13.

Front End view
To view the Front End configuration of an appliance:

@ 1. Select a connected appliance in the navigation pane.

The work pane displays a system overview and lists the devices that are visible
to the backup application via each front-end port.

2. Scroll to view devices that are not visible on the screen.

e Applance Rgpostory ProtecTIER VT  Yiew Hecovery Jook Help

E# [{2) Appliance "Ej q. .,\s x:'; ’,ﬁ) Library & Cartridges ﬁ:, \‘_P: @

166.159.150.130 | i
-1 ek, Mgentcom j Appliance taz.diligent.com
(& Repostory Connected as user  Host Name [ taz.diligent.com
IE . LS .
o Ee e Library front-end _ System overview
Port |Top. | wWwh [um Joevice  [ubrary | i
o (=] 10000000cozhTade [=] 3
0 DOived lbta B [ Read | B white |
1 Drive 1 ib_taz P 5 D00 (MB[Sec) D.00 (MB[5ec)
2 Drivez  lota 1208 o (10fSec) © (10/5ec)
3 Drived  lbta 0§ e
5 Drived b taz 3 Scale graph to !_-‘_\‘11_I MB/Sec |
5 Drive5 b tar kel
6  Drives Wb tas
7 Drive7  Ibta #Spstem Dol
8 Drived b taz |M|
9 Drive9 Wb tas —_— —
10 Drivel0 b ta *| [ Version information ]
11 Drivell Mhtar | ProtecTiER version 122
12 Drivel1z b tas
13 Drive13 b ta | Shaws fices |
14 Driveld Wb ta
15  DrivelS Wb tas
16 Drivel6 M ta
17 Drivel7 b ta
18 Drivels b taz
19 Drive1d b taz
20 Drive20 lib_taz
21 Drve2l b taz
2 Drivez  bta
23 Drve23  Wbta
24  Drive2d b taz
& Dme2s  bta
Frort End Tab [ Ports Atirbues ] =
@ System Onlne  Connected to taz.diligent.com as user B 000 (MBj5ec) [ 0.00 (MBfSec) | Alert

Appliance

@ The name of the displayed appliance is shown, an indication that it is connected, the
host name of the appliance, and its status.

Monitoring ProtecTIER 4-5

Oracle Ex. 1226, pg. 47
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
ProtecTIER

Library front-end

Information is displayed about each front-end port of the appliance, and each device
assigned to the port.

System overview

Throughput of the system is shown on the graph.

If the graphs are not scaled appropriately to display throughput levels, you can
specify the maximum value to be shown on the axis of the graphs.

A green dot indicates that ProtecTIER is online. A red dot indicates that
ProtecTIER is offline.

HyperFactor status is displayed, as well as its throughput (in MB/sec).

last time it was cleared. Click this button to display the error log. See Displaying
the Error log on page 13-4.

iﬁ If the Alerts button is flashing. messages have been added to the error log since the
erts * l

——  Click the Event log button to display the event log. See Displaying the Event
| Events Log I log on page 13-2.

Version information

This is the ProtecTIER version and patch level that is running on the selected
appliance.

4-6 Monitoring an appliance
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Ports Attributes view

Click on the Ports Attributes tab at the bottom of the work pane to view the ports
attributes.

6! ProtecTIER Manager

Fle fApplance Rgpostory ProkecTIERWT View Recovery Took Help
[{b@ Wl&j \_’w‘&ﬂ J Libwar Y&:(Mhlmp—‘g;@:é @

[=] Em?- j Appliance nemo.diligent.com

Connected as operator  Host Name | nemo.diligent.com

[ Port attributes | System overview

Port# (mode) [Win [nk Speed  [Tepclogy  [User satup [5can —

o(FE) 10000000cH44eeb  1G8 LooR AUTO, LOOP (&)

1{FE} 10000000c44eebd  Down [ AT, LOCP & - I Read [ wite ]
0.00 (MB/Sec) 0.00 (ME/Sec)

(1] (I0fSec) 0 (105ec)

® [Scolegraphto E0_Me/sec |

@ System Online

Elzr_ls 1} |_§\-=nu log
| Wersion information

I ProtecTIER Version 1.2.0

Fronk End Tab Ports Attributes

Appliance

@ The name of the displayed appliance is shown, an indication that it is connected, and
the host name of the appliance.

Port attributes
Information is displayed about each port defined for the appliance.

System overview
Throughput of the system is shown on the graph.

If the graphs are not scaled appropriately to display throughput levels, you can
specify the maximum value to be shown on the axis of the graphs.

A green dot indicates that ProtecTIER is online. A red dot indicates that
ProtecTIER is offline.

HyperFactor status is displayed, as well as its throughput (in MB/sec).
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ﬁ If the Alerts button is flashing. messages have been added to the error log since the
l Alerts § | last time it was cleared. Click this button to display the error log. See Displaying
the Error log on page 13-4.

—  Click the Event log button to display the event log. See Displaying the Event
I Events Log | log on page 13-2.

Version information

This is the ProtecTIER version and the subsequent ptlinux and dtcemulex RPM
packages running on the selected appliance.

Additional feature (for administrator use only)
At the bottom of the Ports attributes screen is a Ports attribute button that is used
to invoke the Ports attribute wizard.

See Managing the appliance ports attributes config on page 7-13 for
information of configuring the port attributes.

4-8 Monitoring an appliance
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Displaying ProtecTIER license information

You can view information about the ProtecTIER license installed on an appliance.

1. Right-click an appliance on the navigation pane. You need not be logged in to
the appliance.

2. Choose License from the right-click menu.

ProtecTIER licanse E|
General
License type  SERVER-LOCK
Expiration perpetual
License key  1561442226568701163151212745384823527675
__ProtecTIER properties )
Properky |'v'alue
Max cartridges 819z
Max drives 128
Max libraries 16
Max ports 8
Features
Properky [Enabled [value
Cluster true 1 members
Compression true

The following information is displayed:
General
The License type, Expiration and License key are displayed.
License type
Server lock This license is granted for use on the licensed appliance only.
Expiration
The date on which the license expires, if exists.

License key
A unique key that identifies this license and encodes the information.

ProtecTIER properties

Every configuration operation performed through ProtecTIER Manger will
validate the opcration against the license. If the configuration operation violates a
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license parameter, the operation request will be rejected with the appropriate error
message.

The properties and their values that can be configured via ProtecTIER Manager
under this license are displayed:

max cartridges the maximum number of cartridges per system
max drives the maximum number of drives per system
max libraries the maximum number of libraries per system

max ports the maximum number of ports per appliance

Features

The features for which a license is needed are displayed (e.g. compression).
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Monitoring a repository

For a detailed explanation on how to define and work with repositories, see
Monitoring repositories on page 8-1.

Viewing a repository

To view a repository, select the repository appearing under the appliance in the
navigation pane to which you are logged in. The repository view is displayed. The
Status shows if the repository needs to be checked, or if it is OK.

6 ProtecTIER Manager

Fle Applsnce Repostory  ProtecTIERVT  Wiew Recovery ook Help

LE_;:‘J Appliance *:] B \5 Xj ‘_-j’ Library 4@ Cartridaes T S @
ol e -
[=-N bambi, dikgerit.com R
| 5@ Hmm e
¥ emo. diigent. com Status Ok
=N tas diigenit com : ——
E-@ Repostory Capacity || utilization graph
-1} ProtecTIER VT (ib | = 7 crowih: 27 . )
? 5 Dives Total capacity: 386.0 GB Potentisl growth: 27.0 TB Ofecentdays @ Recent
Sots | 12
I ImpExp
@ atiidges B used: 416GB lg «
[ Free:  344.4GB EESSESE NSNS SE S BERLEN| i
1 I:;I;_ 14:58 (Ui'J-l;_'_— liratb IIUIII.S
| e rescurces | | View metadata resources | | iization [ Metadata wizaton
|_Namunal data size graph | [ HyperFactor ratio over time
O Recent days (& Recent hours O Recent days () Recent hours
e g
Ligd B
SHEENTEIE SRS SES Ec 3
1.2 :
o 8 :
| - pa 1
DEASSEREERRNEIITEARS DRSO | ) SR ER SRR E RN E DS
13710 1458 2058 7 9 Hewri 1310 14:58 20058 02459 Heouri
¥
Total utilization Metadata utilization
sedspace: 41668 i _ | | used space: 1,560.0 M8 [ -
Nominal data size: 81.2 GB L | 4 Total size:  408.3 GB £ | 4
1 pr—

@ System Cnbne  Connected to bambidiigent.com as user B 000 (M8f5ec) B 0.00 (M8fSec) | Alarts

Capacity
Displays the available and used user data space on the repository.

Total capacity
repository.

the total capacity for user data and metadata available on the

Potential growth the maximum future growth capability of the repository.

Used the physical size of the nominal data after it has been reduced by the
HyperFactor and the amount of user data space it takes up on the repository.

Free user data space that is still available for backup purposes on the repository.
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[ewresouces | Displays the file systems that make up the repository.

[View metadata resonces | Displays the metadata file systems that make up the repository and their usage (in
. MB).

Nominal data size graph

Displays the history of the nominal data (in GB) that has been reduced over recent
days or recent hours.

Total utilization

Displays the ratio between the nominal user data size and the actual space it
occupies on the repository.

Used space the physical size of the reduced data that is written on the
repository.

Nominal data size amount of user data that has already been reduced.

Utilization graph

The Utilization tab displays the history of the repository’s physical user data
utilization (in GB) during recent days or recent hours.

Metadata utilization graph

The Metadata utilization tab displays the history of the repository’s physical
metadata utilization (in GB) during recent days or recent hours.

HyperFactor ratio over time

Displays the history of the data compression ratio during recent days or recent
hours.
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Metadata utilization
Displays the ratio between the metadata size and the actual space it occupies on the
repository.
Used space the physical amount of metadata that is written on the repository.

Total size the total physical size of the space available on the repository for
metadata.
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Monitoring a library

When you have logged in to an appliance, its libraries are listed in the navigation
pane under the repository node. The configuration of a library can be displayed.
You can display information about the ports, robot and configuration of the library.

For a detailed explanation of library configuration information, see Displaying the
library configuration on page 9-3.

Select a library in the navigation pane. The configuration of the selected library is

displayed.
[l ProtecTIER Manager =0 |
Fie Applance  Repostory  ProtecTIER YT Wiew Recovery Took  Heip
) | Apphiance 1 tbrery N cortridges < @
(2 %0 <5 .5 5 | 2
ProtecTIER VT NIVLIB
Status 0K  Hyperfactor enabled
| Library front-end_ | [ ProtecTIER VT overview 1
Pot JTop.  Jwwh ____ [un [oevice [ Theoughpet (MBfSec) e
|l fa Fo-AL | 1DD000D0:S300563 i | ot e
T === =]
1 Drived 14 = [ wree ]
2 Drivel 0.00 {MBJSec) 10.73 (MBJ5ec)
3 Dvez L0 [ (10f5ec) 159 (10/5e¢)
+ Dive3 03 0 Active streams. © Active streams
| 5 Drive 4 L = e—— = J
& Drves |_Configuration ]
: E’"‘"': = & Orives in shrek.diigent.com [ ]
xive 1.3 r—
| 9 Drives B slots [10 ]
10 Dxie 9 B importiexport dots [0
1 Driveld
12 Drivell 0.8 & Cartridges [io0 ]
13 Orive 12 [ R | |
14 Drive 13 : L= ]
15 Driveld L | Version mnformation 5
16 Drvels ProtecTIER VT Verscn 40
17 Drivels S—
18 Drivel? Bhowficas
19 Drive 18
20 Divels o
| Re-assign devices |
Robot information
Vendor niame  ATL
Product P3000
Rewvision o100

[l |
@ System Onbne  Connected to shrek.diligent.com as administrator

B 0.00 (MESec) [ 10.73 (MBjSec) |§ Mlerts |

Library

The library is identified. The Status shows if the library is in need of being

checked, or if it is OK. HyperFactor is enabled or disabled for all drives in this

library.

Library front-end
The assignment of this library’s robot and drives to front-end ports is displayed.
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Robot information

This is information about the virtual robot, that will be returned to the backup server
as a response to the SCSI INQUIRY command.

ProtecTIER VT overview

The read and write throughput of the drives in this library and the amount of active
tape drives in the system used for backup or restore are displayed.

The number of configured drives is also displayed.

Configuration
The configuration of the library is displayed.

Version information
This is the version of the ProtecTIER VT.
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Monitoring the components of a library

In the navigation pane, expand the node of a connected library to display a node for
each type of library component: tape drive, internal slot, import/export slot and

cartridge.

Monitoring a library’s tape drives

Click on the Drives node to display information about the library’s tape drives. (For
an explanation of tape drive configuration information, see Displaying tape

drives on page 10-3.)

{6l ProtecTIER Manager

Fie Applsnce Repostory ProtecTIERVT Wiew Recovery Tools Help

s B sotwoce 421 -5 B 1

Library &' Cartridges 2 SRD
-

¢

| 5% nemo. diigert com »
| E-§ repostory \f_, ProtecTIER VT lib_final_test : Drives
T | owe 1o sars (1) (@ () O] Goteowe [ (@]
”g gl [ Configuration
[ ImeExp | OriveNo. [loaded  [VendorName [ProductMame [Rewsion  [Port [LUN [Address | Barcode
@ Cartridges || @ QUANTLM DLT7000 0100 0 1 16
i1 [ QUANTLM OLT7000 0100 o 2 17
2 [ QUANTUM oLT7000 0100 0 3 18
3 [ QUANTLM oLT7000 0100 (1] 4 18
4 [ QUANTLM OLTT000 0100 o 5 20
is @ QUANTLM DLT7000 0100 0 6 21
6 [~ QUANTLM DLT7000 0100 0 7 2
i7 @ QUANTLM DLT7000 0100 0 8 23

Monitoring a library’s internal slots

Click on the S/ots node to display information about the library’s internal slots.
(For an explanation of slot configuration information, see Displaying slots on

page 10-7.)

6 ProtecTIER Manager

Fle fpplance Repostory ProtecTIERVT View Recovery Tooks Help

1) Appliance *j i“ _'\5 _.- & | ubrary #_1 Cartridges %:, \'_}': @
= ??Zgﬁ;:m ProtecTIER VT lib_final_test : Slots
= op'—&::::: il slots  1- 23of 32 | [4®r [ Hext Slots » | [}] coteswt [ |[Ge
[ Conliguration
[ ImExp |~ Sotho. |Address  |Barcods | Capacty(MB) | Ciata Sce (MB)
4 Cartrdges {1y 1040 12233 50668 a2
I 1041 112234 50688 sz
|2 1042 1223 50683 w882
I3 1043 1223% 50683 w88
4 1044 nzy 5088 w2882
15 1045 1123 50669 e
ls wssz
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Monitoring a library’s import/export slots

Click on the Imp/Exp node to display information about the library’s import/export
slots. (For an explanation of import/export slot configuration information, see
Displaying import/export slots on page 10-11.)

6 ProtecTIER Manager
Fle Applance Repostory ProbecTIERWT View Recovery Tooks Help

B B e 48 (5 8 50 2 2 48 e 5 D

- ¥ rema, diigent. com

5 Repostory | =% ProtecTIER VT lib _final_test : ImportExports
=) ProtecTIER VT (it L e " e
- Drives ImportExports 0- Oof O 14| | 4Brev ImportExports | | Next ImportExports » | | b o to ImportExport | | Go
8 _Con O s e — —_—
L% Cotviges || [t [addess  Toorcode | Copacky(re) |Dots See (5] |

Monitoring a library’s cartridges

Click on the Cartridges node to display information about the library’s cartridges.
(For an explanation of cartridge configuration information, see Displaying
cartridges on page 10-14.)

[l ProtecTIER Manager

Fie Applance Repostory ProtecTIER VT  View Recovery Took  Help

B B omee 48] (B (81 S o Jf oo > | [P

Ei- nemo.digent.com | ] ] o L
(=~ Repostory ProtecTIER VT lib_final_test : Cartridges
=) ProtecTIER VT (i 4 e —
T tods | Cartridges  1- 23of 32 4| [4Prev Cortridoes | [Mest Cartridges | [M]  GotoCartridge [ ][ Ge
Sty Configuration
_Q _:3 « Barcode | Write enabled | Capacky (MB)_| Data Se (M)
— 112233 v 50688 32682
112234 v 0688 2582
112235 v 0688 w842
11223 v 50668 £
112237 v 50668 E=E
112238 v 50688 £
122, v 0688 382
112240 v 50658 s
Il 112241 v 0683 1644
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Operating ProtecTIER

5

When you log in to an appliance as vtfoper, you must respond to any
situation that arises during day-to-day operation of the backup
application, that requires operator intervention.

A user who has been assigned the operator role can perform the
monitoring functions of the ProtecTIER user, and can also perform
routine library management operations such as enabling or disabling
tape drive compression, moving cartridges, unloading tape drives, or
resetting tape drives or robots.

You can only perform those tasks that are permitted to the role assigned
to your username.

It is assumed that you are familiar with the tasks of the vtfuser user as
described in Chapter 4, Monitoring ProtecTIER.

Overview of operator activities. .. ....................... 5-2
Managing tape drivesand robots. ... ......... ... ... L. 5-3
Managing cartridges .. .............. ... 5-5
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Overview of operator activities

Managing tape drives and robots

Controlling HyperFactor

You can set the HyperFactor mode of a library.

Unloading tape drives
You can unload a cartridge that resides in a tape drive.

Releasing tape drives and robots
If necessary, you can release a tape drive or a robot.

Managing cartridges

Moving cartridges

You can move a cartridge from one drive or slot to another. To move a cartridge
from a tape drive, you must first unload it.

Changing cartridge properties

You can toggle a cartridge between read/write and read-only.
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Managing tape drives and robots

Set HyperFactor mode

From the ProtecTIER VT > ProtecTIER VT Library menu, select the Set
HyperFactor mode option.

Important

HyperFactor mode is for Troubleshooting only.

The HyperFactor mode of a library can be set to one of the following three modes:

Library data reduction

Enable/disable data reduction, or set baseline,

() Data reduction enabled
(O Data reduction disabled
@ Baseline

|E | Cancel

HyperFactor enabled

Enabling HyperFactor is highly recommended.

Allow the HyperFactor to process the library cartridges and reduce the storage space
they occupy. This is the recommended mode.

Important

The following two modes, HyperFactor disabled and Baseline. are for
Troubleshooting only. Do not set these modes unless Technical Support instructs

you to do so.

HyperFactor disabled

The library cartridges are not subject to the HyperFactor.

Baseline

The library cartridges are not reduced by the HyperFactor, but their data is used by
the HyperFactor as reference for HyperFactor operations.
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Unloading a drive, resetting a drive or robot

These actions are described in detail in Performing tape drive actions on
page 10-5, and Resetting the robot on page 9-24.

Important

Do not perform these operations while the backup application is using the library.
Doing so may damage the operations of the backup application.

Unloading a tape drive

If a tape drive contains a cartridge, you can unload it.

Before you move a cartridge from a tape drive, you must unload it.
1. Display the list of tape drives of a library.

2. Right-click on a full drive in the list.

3. Choose Unload drive from the right-click menu.

Resetting a tape drive

You can perform a SCSI reset of a tape drive.

1. Display the list of tape drives of a library.

2. Right-click on a drive in the list.

3. Choose Reset drive from the right-click menu.
4. Confirm the action.

Resetting the robot

You can perform a SCSI reset of a robot.
1. Display the library properties.

2. Choose Library > Reset robot.

3. Confirm the action.
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Managing cartridges

Moving cartridges

You can move cartridges from one location to another. Before you can move a
cartridge from a tape drive, you must unload it.

1. Display a list of tape drives or internal slots or import/export slots.

2. Select the cartridges you want to move.

3. Press <Shift> and right-click to choose Move cartridges from the menu. The
Move Cartridge dialog is displayed.

Move cartridge @

Mowe 8 cartridges from slots

Destination Type [lok Iz‘

Destination

(@) Mext Available

|Q__}'] | Cancel I
Destination type In the Destination type box, choose Drive, Slot or

Import/Export.

Destination If you have chosen to move the cartridge to a drive, choose the
number of the drive. If you have chosen to move the cartridge to a slot, you can
specify the slot number, or you can have the cartridge moved to the next available
slot.

Changing the read/write mode of a cartridge

When a cartridge resides in a slot or an import/export slot, you can toggle its write
mode between read-only and read/write. When the cartridge is located in a tape
drive, its read/write mode cannot be changed.

1. Right-click on the cartridge whose read/write mode you want to change.
2. Choose Read/write cartridge from the right-click menu.
3. Confirm the action.
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Administering ProtecTIER| 6

When you log in to an appliance as ptadmin, you can perform all the
functions of an operator, and you can also perform appliance
configuration operations.

Only one administrator user can be logged in to an appliance at a time.
If you attempt to log in to an appliance as administrator, and there is
already a user logged in as administrator, you will be notified which
other user is logged in, and you will be asked if you want to force the
other user’s session to end. If you proceed with the login, the other user
will be logged out with no warning,

It is assumed that you are familiar with the information in Chapter 4,
Monitoring ProtecTIER and Chapter 5, Operating

ProtecTIER.

Overview of administrator activities. . .................... 6-2
Initial system configuration. . ........................... 6-4
Modifying the configuration . . .. ........ ... ... ... ....... 6-5
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Overview of administrator activities

The ProtecTIER administrator tasks are performed when virtual tape libraries are
defined and a repository is created.

Important

Do not perform configuration operations while the backup application is using the
library. ProtecTIER goes into an offline state temporarily, while the configuration

is being changed.

Initial system configuration

The REO 9500D appliance arrives at the user site with an initial library of 8 drives,
and 200 cartridges split between the two FC ports.

ProtecTIER version upgrades

After a ProtecTIER version upgrade might require upgrading the libraries to be
compatible with the new ProtecTIER version. (See the release notes for details and

instructions on how to execute the upgrade.)

6-2 Overview of administrator activities
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Modifying the configuration

ProtecTIER Manager’s wizards guide you in the performance of
administrator activities, such as:

o creating and deleting libraries, and changing the configuration of
existing libraries

o adding cartridges to a library

o assigning tape drives and robotics to front-end ports

o checking a library that appears to be damaged

o setting appliance port modes

o setting appliance port attributes

Administering ProtecTIER 6-3

Oracle Ex. 1226, pg. 69
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
ProtecTIER

Initial system configuration

The REO 9500D appliance comes pre-installed with one library. The library has 8
drives and 200 cartridges. The robot and 4 drives are assigned to FC Port 0, and
4 drives are assigned to FC Port 1.

6-4 Initial system configuration
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Modifying the configuration

As you work with the system, and gather performance statistics, you can change the
library configuration to improve performance. For more information, see PART
TWO - Using ProtecTIER.

Working with ProtecTIER Manager
Use the ProtecTIER Manager display to access information and perform actions.
ProtecTIER Manager wizards guide you in performing administration tasks.
For more information, see Working with ProtecTIER Manager on page 3-1.

Managing appliances
Use ProtecTIER Manager to log in to one or more ProtecTIER appliances for which
you wish to perform user, operator or administrator activities.
For more information, secc Managing appliances on page 7-1.

Managing libraries

If your username is authorized to perform administrator tasks on libraries, you can
create or delete a library, add cartridges to a library, change the number of drives
and slots, detach or attach a library, perform an integrity check, and change the
front-end assignment of the robot and tape drives.

For more information, see Managing libraries on page 9-1.

Managing ProtecTIER components
You can display information about the tape drives, internal slots, import/export slots
and cartridges in a library.

You can unload a tape drive, and move a cartridge from one slot or drive to another,
and provide other actions.

For more information, see Managing library components on page 10-1.
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PART TWO - Using ProtecTIER

These chapters describe how to access the REO 9500D
appliance via the ProtecTIER Manager client, and how to
perform user, operator and administrator activities.

PART TWO - Using ProtecTIER 1
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Managing appliances

7/

Use ProtecTIER Manager to log in to one or more REO 9500D
appliances for which you wish to perform user, operator or
administrator activities.

Getting started . . .. ... ... .. 7-2
Auto-discovery of appliances .. ......................... 7-3
ProtecTIER Manager update settings . .. .................. 7-4
Providing connection properties for an appliance. ........... 7-5
Editing or viewing connection properties .. .. ............... 7-6
Removing connection to an appliance. .................... 7-7
Loggingintoanappliance ........... ... ... ........... 7-8
Logging out fromanappliance . ......................... 7-9
Managing the appliance front-end config . . ............... 7-10
Managing the appliance ports attributes config ............ 7-13
Managing the ProtecTIER trace ........................ 7-19
Creating a sServiCe report . . . .. oo v vt e 7-21
Saving performance history. . . ........ ... ... .. .. ... 7-23
Updating ProtecTIER .. ... ... ... ... .. .. ... ...... 7-24
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Getting started

When you invoke ProtecTIER Manager, you are not logged in to any appliances.

[ ProtecTIER Manager

Fie Apglance Repostory HyperFactor  FrotecTIERVT Wiew Recovery Tooks Heb

E_’ [{, Anpl °*:| }__ _'\5 | 4 Library ‘L_\ill.mmm.-‘ \q‘;' \‘}: @
o

b fione, diligent..com Mot connected

I (i

HyperFactor |_Please take the following action:

B~ ) ProgecTIER VT (perfon To connact to applance, chick on the Login button

r 168.159.150.175 3 "
‘ :E e Appliance earth.diligent.com
|
‘ i panter.disgent.com

Login to apphiance |i?@|

If you have added appliances in previous sessions, or if auto-discovery is enabled,
these appliances are listed in the navigation pane at the left of the screen, as
unconnected appliances.

These actions are enabled:

Exit from ProtecTIER Manager.

Add appliance.

If appliance is selected in the navigation pane, log in to an appliance for which
connection properties have been provided.

»

If appliance is selected in the navigation pane, remove an appliance from the list in
the navigation pane.

Ifappliance is selected in the navigation pane, view or edit the connection properties
of an appliance.

I &

] Display ProtecTIER Manager version and copyright information.
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Auto-discovery of appliances

When you invoke ProtecTIER Manager, ProtecTIER Manager searches for
appliances on specific subnets of the TCP/IP network.

After scanning the network, you can modify the list of appliances in the navigation
pane - adding appliances manually, or deleting appliances.

You can re-scan the network, at any time, to refresh the list of appliances in the
navigation pane.

Specifying subnets containing appliances

1. Choose Tools > Preferences.

2. For the subnets on which your appliances reside, enter the first three numbers of
the IP address. The fourth number should always contain the mask value 255.

3. Click Ok.

Preferences @

|| Auto discovery || Update settings | Logging | Wigwy |

r TCRJIP Sub Metwork

[] sub netwark 1
[ sub netwark 2
[ sub network 3
[] sub network 4

| -.-!”| | Cancel

When you click Ok, ProtecTIER Manager scans the network and lists in the
navigation pane all appliances on the specified subnets.

Refreshing the navigation pane

You can re-scan the network, at any time, to refresh the list of appliances listed in
the navigation pane.

To re-scan the network, right-click on the navigation pane (not on an object listed
there) and choose Auto discovery on the right-click menu.

Appliances discovered while scanning the network are added to the list in the
navigation pane if they were not listed. Their connection properties are refreshed if
they are listed.
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ProtecTIER Manager update settings

The update settings are used by ProtecTIER Manager to connect to Diligent’s
extranet in order to update the ProtecTIER Manager software.

1. Choose Tools > Preferences. The Preferences dialog is displayed.
2. Choose the Update settings tab.
3. Click OK.

Preferences g]
Auto discovery Update settings [Logging View |

- GUI update properties
@ Host name: m‘
O 1Ip address: I:I
User name:
Password:

Ok | Cancel

The User name and Password fields are automatically filled in.
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Providing connection properties for an appliance

In order to connect to an appliance that does not reside on a subnet that is scanned
via the auto-discovery feature, you can provide the appliance’s connection
properties and store them. These properties are used when you log in to the
appliance.

The connection properties you have added are saved, for your user name, when you
exit ProtecTIER Manager, so that you can log in to an appliance in your next session
using its stored properties.

1. Choose Appliance > Add appliance to invoke the Add appliance dialog.
™ |
%) 2. Enter the information and click Ok.

Add appliance @

IP address:  |[168.159.150.11 ';'1|

Port:

You can store an IP address to connect to the appliance when you log in. The
appliance is represented by its host name in the navigation pane.

IP address
The IP address of the appliance.

Port

The TCP/IP port number that is used by ProtecTIER Manager to connect to the
appliance. Port number is specified by default.

It is strongly recommended that the port number not be changed.
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Editing or viewing connection properties

For a disconnected appliance, you can modify the connection properties that are
stored for the appliance.

For a connected appliance, you can view the connection properties that are stored,
but you cannot change them while you are logged in to the appliance. Objects on
the dialog appear dimmed.

% @ 1. Select an appliance in the navigation pane.

2. Choose Appliance > Connection properties to invoke the Connection

L.-"’J/’ properties dialog.

3. The connection properties of the appliance are displayed. Ifthe appliance is not
connected, you can change the information and click Ok.

Connection Properties @

IP address:  [168.159.150.130

Port:

=01 |

5]

You can store an IP address to connect to the appliance when you log in.

IP address
The IP address of the appliance.

Port

The TCP/IP port number that is used by ProtecTIER Manager to connect to the
appliance.

It 1s sirongly recommended that the port number not be changed.
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Removing connection to an appliance

If there is an appliance listed in the navigation pane, and you no longer need to log
in to this appliance, you can remove it from the list in the navigation pane.

This affects only your user sessions. The connection properties for this appliance
are deleted from the list that is stored for your user name.

E 1. Select the appliance in the navigation pane. It can be either connected or
disconnected.

Choose Appliance > Remove appliance.

24
X_J 3. Confirm the action.

Remove Appliance @

+ Remove connection to
@H Iynx.diligent.com?

m=m

If you were logged in to the appliance, you are logged out automatically.

The appliance is no longer listed in the navigation pane.

appliance option to provide its connection propetties, or use the Auto discovery

E If you need to log in to this appliance in the future, you must use the Add new
setting option.
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Logging in to an appliance

Once the connection properties of an appliance have been stored, you can log in to
the appliance by providing a valid Username and Password.

E 1. Select a disconnected appliance in the navigation pane.

: : 2. Click the Login button to invoke the Login dialog.
’_ @ Login 3. Type the Username and Password information and click Ok to log in to the

appliance.
Username: | |
Password: | |
[] Save password |£|
Username

Select a valid ProtecTIER username:

o ptuser for monitoring ProtecTIER
o ptoper for operating ProtecTIER
o ptadmin for administering ProtecTIER

Password

The password for each user is:

o ptuser password is ptuser

o ptoper password is ptoper

o ptadmin password is system
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Logging out from an appliance

You can log out from an appliance in order to log in under a different user name, or
to allow access from another workstation.

When you exit from ProtecTIER Manager without logging out from the appliances,
you are automatically logged out.

1. Select a connected appliance in the navigation pane.

K.
B 2. Choose Logout from the right-click menu, toolbar, or appliance menu.
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Managing the appliance front-end config

When you have logged in to an appliance, the VTLU libraries attached to the
appliance are listed in the navigation pane under the appliance node.

When you select a connected appliance, the work pane displays the front-end port
Ja configuration, a system overview, and information about the ProtecTIER version
and patch level that is running on the appliance.

To view the ports attributes configuration, click on the Port Attributes tab at the

bottom of the work pane. (See "Managing the appliance ports attributes
config" on page 7-13. for more details.)

[dl ProtecTIER Manager

Bl fpplance Rgpostory ProtecTIER VT View Recovery Took Help

E'a @ Appliance *“J 5 )5‘ X: _.,_/’ Library B cartridges i.;( b @

_} ::f:;gq:fffzf | = Appliance taz.diligent.com
- Repository \'.J Connected as user  Host Name | tazdiligent.com
i ??.mﬂh |_Library front-end _ ) ) | [ System overview
Port_[Top. [wewm [ Joevke [ubrary L1 eeponts
0 (3 10000000 Iz Tede -l
0 Drived I tas T [ERead [ wree |
1 Drivel b taz I 0.00 {MBfSec) 0.00 (MBSec)
2 Drivez bt 0 (10j5ec) 0 (105ec)
3 Drive3 Mo tar E T —
4 Dved bt " | scole graphto o0 |rb/Sec
5 Drive5  bta
6  Drives o taz
7 Drive7  lbta: @ System Ooline
8  Drives  bta: (Eeiom ] |
9 Drived b tar a8
10 Drive10 b taz | [ Version infarmation 7|
11 Drivell lb_taz T Vi —
12 Drivel12 b taz
13 Drive13 b _tas EN f"'ﬂ |
14 Drivel4 b taz
15  Drivels lib_taz
16 Drivels lib_taz
17 Drive17 lib_taz
18 Drive18 lib_taz
19 Drive19 lib_taz
20 Drive20 lib_taz
21 Drive2l lib_taz
22 Drive2z lib_taz
23 Drive23 lib_taz
24 Drive2d lib_taz
25  Drive2s lib_taz
-
Front End Tab | Ports Attributes |
@ System Cribre Connected to taz.diligent.com as user B 0.00 (MB/Sec) 0.00 (MBfSec) | Aot
— = Appliance
=

The host name of the displayed appliance is shown
Connected an indication that you have logged in to the appliance
Host name the host name of the appliance
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Front-end configuration

This is a display of the devices that are visible to the backup application via each
front-end port.

Scroll down to display devices that are not visible on the screen.

The port number, topology and world wide name are displayed for each front-end
port of the appliance.

The LUN, device type, and library are displayed for the robot and tape drives that
are visible to the backup application via that port.

Port

The front-end port number, through which the backup server views the listed
devices.

Top

The type of Fiber Channel topology used for the port.

P2P point-to-point.

FC-AL arbitrated loop.

DOWN no Fiber Channel connection is detected.

WWN

The world wide name of the port.

LUN

The logical unit number of the tape drive device or the robot device, with respect to
this port.

Device

An indication of whether the device is the robot or a tape drive.
For a tape drive, the index number of the tape drive within the library is indicated.

Library
The library to which the device belongs.
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System overview

| Alerts ¢ |
I Events Log |

FE ports

Read throughput (blue) and write throughput (orange), in MB/sec, of each front-end
port, are shown on the graph.

Scale graph to

If the graph, above, is not scaled appropriately to display throughput levels for this
appliance, you can specify the maximum value to be shown on the axis of the graph.
Type the value (minimum value is 5).

Read

Read throughput in MB/sec.
Number of read I/O operations per second.

Write

Write throughput in MB/sec.
Number of write I/O operations per second.

System online/offline
A green dot indicates that ProtecTIER is online.
A red dot indicates that ProtecTIER is offline. This may indicate that ProtecTIER

has been taken offline automatically to allow changes in configuration, and that it
will be brought online automatically when the configuration has finished.

If the Alerts button is flashing. messages have been added to the error log since the
last time it was cleared. Click this button to display the error log. See Displaying
the Error log on page 13-4.

Click this button to display the event log. See Displaying the Event log on
page 13-2.

Version information

Show Fixas

ProtecTIER version

The ProtecTIER version and the subsequent ptlinux and dtcemulex RPM packages
running on the selected appliance.

Click this button to display the Fixes dialog. The version number of the patch is
displayed with the list of fixes contained within the patch.
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Managing the appliance ports attributes config

When you have logged in to an appliance, the VTLU libraries attached to the
appliance are listed in the navigation pane under the appliance node.

E When you select a connected appliance, click on the Ports Attributes tab at the
bottom of the work pane to display the ports attributes configuration.
To view the front end configuration, click on the Front End Tab at the bottom of

the work pane. (See "Managing the appliance front-end config" on page
7-10. for more details.)

6 ProtecTIER Manager

Fle Applance Repostory  ProtecTIERVT  View  Recovery Tooks Help
Ps B rovtence 1) 6 (8B yf] [F | vbrorr JB corioons > T | [B
el 03 03 x| |
1=~ ¥, nemo,digent. com 4 o
549 Repostory Appliance nen'bo.d|llga'1t.corr_1__
Connected as operator  Host Name | P
|_Port attributes [ System averview
| Porta (mode) [wwn |unk Speed | Tepology |User satup {Scan FEPorts
0(FE) 10000000c944eb2  1GB LOOP ALTO, LOOP | & |
1 (FE) 10000000c544eeb3 Down Down AUTO, LOGP &= [ [Wread [ write |
19, oo (ME/Se) 0,00 (MB/Sec)

3 {10fsec) @ (10j5ec)
180 w 1

" | scale graphto [200 | MB/Sec |

@ System Online

| [Rests 1] Events Log |

e
| ProtecTIER version 120

Fronk End Tab | pots Attributes |

~ = Appliance
| The host name of the displayed appliance is shown

Connected an indication that you have logged in to the appliance
Host name the host name of the appliance

Port attributes

This is a display of the ports that are available to the appliance.
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The port number, WWN, link speed, topology, user setup and scan option are
displayed for each port.

Port
The port number and the port mode.

FE Front-end port connecting ProtecTIER to the backup server(s)

WWN

The world wide name of the port.

Link Speed

The actual transmission speed used on this link.

Topology

The actual type of Fiber Channel topology used for the port.
switched fabric

P2P point-to-point

FC-AL fiber channel - arbitrated loop

DOWN no Fiber Channel connection is detected

User setup

Link speed and topology as configured by the user through the Port attribute
wizard. The link speed setting options reflect the options supported by the HBA.

(G | Scan

Displays the WWN of the remote ports as seen through the port.

\@ Port attributes

Invokes the Port attributes wizard.
System overview

FE ports

Read throughput (blue) and write throughput (orange), in MB/sec, of each front-end
port, are shown on the graph.

Scale graph to

If the graphs, above, are not scaled appropriately to display throughput levels for
this appliance, you can specify the maximum value to be shown on the axis of the
graphs.
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You must use the up-arrow or the down-arrow to change the values. Values you type in are
not accepted.

Read

Read throughput in MB/sec.
Number of read I/O operations per second.

Write

Write throughput in MB/sec.
Number of write I/O operations per second.

System online/offline

A green dot indicates that ProtecTIER is online.

A red dot indicates that ProtecTIER is offline. This may indicate that ProtecTIER
has been taken offline automatically to allow changes in configuration, and that it
will be brought online automatically when the configuration has finished.

HyperFactor status
Displays the HyperFactor status and throughput in MB/sec.

—_' If the Alerts button is flashing. messages have been added to the error log since the
| Alerts | last time it was cleared. Click this button to display the error log. See Displaying
the Error log on page 13-4.

[E—_ Click this button to display the event log. See Displaying the Event log on
Events Log |
page 13-2.
Version information

ProtecTIER version

The ProtecTIER version and patch level that is running on this appliance.

Ports attribute wizard

Click the Port attributes button at the bottom of the Ports attributes screen to
invoke the Port attributes wizard. This wizard enables you to configure the Link
Speed and the Topology for each port.

Important

Do not perform configuration operations while the backup application is using the
library. ProtecTIER goes into an offline state temporarily while the configuration
is being changed.

Managing appliances 7-15

Oracle Ex. 1226, pg. 89
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
ProtecTIER

Welcome
The dialog opens the wizard. Click Next to proceed.

mars. diligent.com : Port attributes

Port attributes
Welcome
+ Melcome This wizard will guide you through the process of configuring the port attributes (speed and
Ports Details topolagy).

Report

[ Heip | [ qprev |[ gexn] [ Fmist || cancel ]

Ports Details

The dialog displays a list of the ports and their configuration values.

To change the Link Speed value for a port, click on the drop-down arrow in the
Link Speed field for the port and select a new value. The values listed in the drop-
down box are dependent on the HBA support.

To change the Topology value for a port, click on the drop-down arrow in the
Toplogy field for the port and select a new value.
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Make sure you choose the correct port Topology and Link Speed values, or you may
lose your link to your backup servers.

mars. diligent.com : Port attributes

X
DILIGENT ProtecTIER
Port attributes -

Port attribute setup
+ Welcome
Port# IWWN IMode ILink Speed Topolagy
+ Ports Details 0 10000000c92bd2e4  FE 1GE [=] Loop [[«]
Report 1 10000000c92bd2e5  FE auto  [+] |ooOP |
2 10000000c3426832  FE amo [+ B —
3 10000000c9426831  FE auto  [=] Loop =]
Help | | 4 Prev ” Mexk b ] | Finish || Cancel |

When all desired Link Speed and Topology values have been updated, click Next
to execute the changes.

Managing appliances 7-17

Oracle Ex. 1226, pg. 91

Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
ProtecTIER

Report

The dialog displays the ports with their updated Link Speed and Topology values.
If no changes have been made, the Summary report will so indicate.

&

mars. diligent.com : Port attributes

DILIGENT ProtecTIER
Port attributes
S ¥ report
« Welcome Port 0: Speed changed to 1GB and Topology changed to P2P

+ Ports Details

+ Report

| Heb | | 4prev H.H---r» [ | inish || cancel |

Click Finish to exit the wizard and execute the changes. The Port attributes
screen is displayed.
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Managing the ProtecTIER trace

You can set trace levels, dump or reset the ProtecTIER appliance program trace so
that the appropriate trace information will be entered in the problem report.

Set the ProtecTIER trace levels

Important

Do not change the tracing and logging levels if you are not asked to do so.

Use the Set trace levels dialog to modify the tracing and logging levels of the
ProtecTIER appliance. You may receive a request from Technical Support to
modify the tracing or log levels of a specific ProtecTIER component for
troubleshooting. Changing the levels may affect performance.

1;

2.
3.
4

Log in to an appliance as administrator.
Select this appliance in the navigation pane.
Choose Appliance>Set trace levels.
Confirm your choices.

nemo. diligent.com : Set trace levels E|

Use this dialog ko adjust server modules trace levels as desired, Mote that any change might influence the

overall performance of the system, therefore it is not recommended unless instructed by Diligent C55.

rLog threshhold Syskem default:

‘ Threshhald TRC_ERR [~] ‘ ’V| Restore defaults | Restore system defaults

rTrace level
YTLMain TRC_INFO [~] Fhm TRC_INFO [~ ﬁ
YTLCEs TRC_INFO [~ Fim TRC_INFO [~
YTLTrgCol TRC_DEBUG  [7] Sta TRC_INFO [~
YTLTape TRC_DEBUG  [7] Stm TRC_INFO [~
YTLRobat TRC_INFO [~ Sto TRC_INFO [~
YTLCacheBuf TRC_INFO [~ Toc TRC_INFO [~

| o3 | Cancel
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Dump the ProtecTIER trace

Use this option to create a new dump file of the ProtecTIER internal trace, to the
working directory: /fx_work. This is used for troubleshooting when you are
requested by Technical Support to provide trace information.

1. Log in to an appliance as administrator.

o

Select this appliance in the navigation pane.

d

Choose Appliance>Dump ProtecTIER trace.

&

Confirm your choice.

Dump trace

@- Do you want to dump program trace?

B

The files are saved with the current appliance timestamp, in this format:
ring_<module> <pID> <timestamp>.rng

Reset the ProtecTIER trace

Use this option to empty the trace memory, so that any future trace dump will start
from this time stamp.

1. Log in to an appliance as administrator.

L

Select this appliance in the navigation pane.
Choose Appliance>Reset ProtecTIER trace.

g ke

Confirm your choice.

@- Do you want to reset program trace?

mm
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Creating a service report

You can generate a service problem report to send to Technical Support.
1. Choose Appliance>Create service report, the Create service report dialog
is displayed.

nemo. diligent.com : Create service report

Fill in the service report fields to continue.

rCustomer information

Customer site: ||

rBackup application

Host operating systern: | |

Backup application name: | |

Backup application version: | |

rProblem description
Briefly describe the problem

5]

Complete the form with a brief description of the problem. Click OK.

A dialog is displayed asking if you want to download the file to the host (i.e. the
machine running ProtecTIER manager) and add the ProtecTIER manager log
files.

Create problem report [ %

Problem report successfully created,
‘? Do you want to download the file and
t . add ProtecTIER manager log files to
it?

&)
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4. Click Yes, an add/remove file dialog is displayed. Select what files you want to
add to the service report. Click OK.

Please add any other files to the Report

Hi\ syren\1\rel_6111_00S\work.geraldymanager0.log [add.. |
H:\.syren\1irel_6111_00Siwork.geraldimanager!.log —
Hel.syrentlirel 6111_00S\work geraldimanager2.log [Remove |

5. A zip file containing the service report and the added log files is automatically
created. Name the zip file and save it in the desired directory.

saveln: |(J workgerald =] BE

L) ProtecTier_a_Nov_15_2005_16_23_21_report

D FrotecTier_eeeeee_Mov_15_2005_14_26_47_report

u ProtecTier_W_Mov_15_2005_15_15_28_report
| ProtecTier_zzzzz_Ncv_15_2005_14_27_44_report

File Name:

Files of Type:  |zip files

]

save || cancel |
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Saving performance history

You can save and analyze the long-term performance statistics of ProtecTIER. The
data file is saved in XML format that can be viewed in Microsoft Excel.

1. Choose Appliance > Save performance history. The Save dialog is

displayed.

[t save

X]

Save In: ||LJ My Documents

[ @ @) BE

L] My eBooks

) My Music

U ity Pictures

(J My PSP Files

() My PSP8 Files

) My Received Files

) My Skype Pictures

() My Skype Received Fi es

L My videos
U My Wehs
U Fersonal
J vTFOpen
| testxml

File Name: |

Files of Type:  [XMIL files

(=]

Save l Cancel

2. Choose the desired directory in which you want to save the file and type the
desired file name. Click Save.
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Updating ProtecTIER

You can check if there are available updates to the current releases of ProtecTIER
Manager and the ProtecTIER software that you are using.

Checking for ProtecTIER Manager updates

To check if there is an available update to the current release of ProtecTIER
Manager:

1. Choose Tools > Update. The Update dialog is displayed.

This operation will check for available

@ ) updates.

Do you want to continue?

2. Click Yes to continue. Data is collected from the Update site regarding whether
or not an update exists:

m Ifan update is available, the following dialog is displayed with a link to view
the release notes relevant to the latest update.

ProtecTIER Manager update

A new version exists.
@ Do you want to download updates?
-

{ Click to show release notes )

(=)=

Click Yes to download the latest ProtecTIER Manager update. The
application files are transferred to the ProtecTIER Manager directory via a
temp folder.

3
DICIGENT ProtecTIER

f =. Transferring application files...
@ Flease wait while performing required operations

Status: Transferring ¥1.4.0%application.jar to temp Folder 171
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Once the update is completed, restart the application for the changes to take
effect.

m I the ProtecTIER Manager update is not compatible with the ProtecTIER
software version, you will be prompted to download a new software
package.

m If no updates are available, the relevant dialog will be displayed.

ProtecTIER Manager update E|

| e Mo updates available. ‘

Checking for a ProtecTIER software patch
To check for a ProtecTIER software patch:
1. Select a connected appliance in the navigation pane.

2. Choose Appliance > ProtecTIER patch update check. The ProtecTIER
patch download dialog is displayed.

Scan forupdates

ation will check for

€©) v

" Do you want to continue?

mm

3. Click Yes to check for available updates. If a patch does exist based on the
appliance’s ProtecTIER version, the following dialog is displayed.

Scan forupdates

A new patch exists,
@_ Do you want to read the release
~ notes?

If a patch does not exist based on the appliance’s ProtecTIER version, the
following dialog is displayed.

Scan for updates

e hux. diigent.com No relevant updates exist,
e
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Monitoring repositories| 8

Monitor a repository using ProtecTIER Manager.
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Overview

Repository

A storage repository is a basic partition of the total visible storage and it is the
storage space of an instance of a compressible file system. The repository is a
collection of file systems that is used to store the data and metadata. Libraries are
created on a repository.
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Monitoring fragmentation in a repository

ProtecTIER controls the level of fragmentation in the repository by managing
defragmentation background processes. Choose Repository > Defragmentation
control, the Defragmentation control dialog is displayed.

nemo. diligent.com : Defragmentation control @

Manitor the level of fragmentation in the repository, and
enable/disable defragmentation,

Status
Fragmentation level: low
Defragmentation status: enabled

| Enable defragmentation ] | Disable defragmentation |

The Fragmentation level is displayed as low, medium, or high. The
Defragmentation status of background processes can be either enabled or
disabled.

Click Enable defragmentation to enable the defragmentation background
Processes.

nemo. diligent.com : Enable defragme... [z|

| o Defragmentation was enabled ‘

Click Disable defragmentation to disable the defragmentation background
Processes.

nemo. diligent.com : Disable defragme... @

‘ e Defragmentation was disabled ‘

Defragmentation should be disabled enly when explicitly requested by service personnel.
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Managing libraries

S

You can use ProtecTIER Manager to display the configuration of a
library.

If your username is authorized to perform operator tasks, you can move
cartridges, reset the robot and drives, unload drives, modify cartridge
read/write permissions. For more information, see Chapter 5,
Operating ProtecTIER.

If your username is authorized to perform administrator tasks on
libraries, you can create or delete a library, add or delete cartridges
from a library, change the number of drives and slots, perform an
integrity check, change the front-end assignment of the robot and tape
drives, set HyperFactor mode, rename library, rebarcode cartridge.

O VI W e S SR TR - <« o oo e ma e 9-2
Displaying the library configuration. . .................... 9-3
Creatinganew library. .. ............ .. ... ... ... ....... 9-7
Changing the library configuration...................... 9-11
Re-assigning robots and drivestoports .................. 9-15
Deletingalibrary........... ... .. ... ... ... ....... 9-18
Adding cartridgestoalibrary .. ......... ... ... ... ..., 9-19
Checkingalibrary............ ... ... .. ... .. .. ....... 9-22
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Overview

When you have logged in to an appliance, its libraries are listed under the repository
in the navigation pane.

Monitoring the library configuration

A library is identified in the navigation pane by the name that was chosen when the
library was created. When you place your mouse pointer over the library name, the
tooltip displays the unique ID of the library.

When you select a library in the navigation pane, its configuration is displayed in
the work pane.

Operating the library

A user with operator authorization can send a SCSI reset to a tape drive or robot,
move a cartridge, modify a cartridge’s read/write permissions, and unload a drive.

Performing library administration

An appliance cannot be used by a backup application until at least one library has
been defined on its repository.

A user with administrator authorization can create, modify and delete libraries.
o Additional libraries can be defined if there is space on the repository.

o An existing library can be modified - cartridges can be added or deleted, the
number of tape drives and slots can be adjusted, devices can be reassigned to use
different front-end ports, and HyperFactor mode can be set.

Important

Do not perform configuration operations while the backup application is using the
library. ProtecTIER goes into an offline state temporarily, while the library
configuration is being changed.

9-2 Overview
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Displaying the library configuration

H In the navigation pane, select a library attached to a connected appliance to display
its configuration.

[l ProtecTIER Manager =1ofx|
Fle MApplance Repostory ProtecTIERVT View Recovery Took Help
) i " -
| Kt | apphiance _:{' Library 5 Cartridges @
(2T 40 o8 (85 | L
i) earth.digent com
;-3-..«« s | Bggl ProtecTIER VT NIVLIB
(-1 mars. cligent.com Status 0K HyperFactor enabled
| Ubrary front-end _ —— R | [ ProtecTIER VT overview "
[Pot [Top. [ wwN Jum [Devce | Thioughpot (MBfSec) ‘ o OGO,
0 FCAL  10000000:33005e9 = L / = N
0 Robot 2 )
R (W T W ]
2 Drivel 0.00 (MBfSec) 10.73 )
3 Drive2 L0 0 (10fsec) 159 (10/5e¢)
4+  Dived 03 [} Active strears 9 Active streams
5 Drived
6 DriveS |_Configuration
: E'::'_‘ o & Drives in shrek.dbgent.com [ ]
wive? 13
9 [DriveB @ st 100
10 Drive? B treortexport shots [0
Il Driveld
12 Drivell 0.9 &y Cartridges | 1oo
13 Drivel2 [ |
14 Drive13
15 Driveld 14 L Version information_
16 Drivels ProtecTIER VT Version 40
17 Drivels 3 —
18 Drive I7 - . | :Muflres-“
19 Drivels
20 Orvels 03
| Re-assign devices |
| Robot information
Verdr rame  ATL
Product P3000
| Revison o100
<] 2|
@ System Onlne - Connected to shrek.diligent.com as administrator B 0.00 (ME/Sec) [ 10.73 (MB[Sec) |t dlerts |
~ Library
'

The library is identified.

Status The status of the library. If the status is not OK, the library is in need of
being recovered.

HyperFactor enabled The status of HyperFactor operations.

Library front-end configuration

Information is displayed about each front-end port of the appliance to which devices
are assigned (ports without devices are not shown), and about each device of this
library (robot or tape drive) that is visible to the backup applications via that port.

The administrator can click the Re-assign devices button to invoke the Re-assign

Re-assign devices : z Pt x
I devices wizard. See Re-assigning robots and drives to ports on page 9-15.
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Port

The front-end port number, through which the backup server views the devices.

Top

The type of Fiber Channel topology used for the port.
switched fabric

P2P point-to-point.

FC-AL arbitrated loop.

DOWN no Fiber Channel connection is detected.

WWN

The world wide name of the port.

LUN

The logical unit number of the tape drive device or the robot device, with respect to
this port.

Device

An indication of whether the device is the robot or a tape drive.
For a tape drive, this column indicates the index number of the tape drive within the
library.

Throughput (MB/sec)
Displays the throughput (in MB/sec) for each port in this library.

Robot information

This is information about the virtual robot, that will be returned to the backup
application as a response to the SCSI INQUIRY command.

Vendor name

The virtual robot behaves like a robot from this vendor.

Product

The virtual robot behaves like a robot of this product type.

Revision
The virtual robot behaves like a robot of this revision number.
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ProtecTIER VT overview

The read (blue) and write (orange) throughput for each drive in this library and the
amount of active tape drives in the system used for backup and restore are displayed.
The number of configured drives is also displayed.

Read

Overall read throughput in MB/sec.
Number of read I/0 operations per second.
Number of active streams.

Write

Overall write throughput in MB/sec.
Number of write I/O operations per second.
Number of active streams.

The reading/writing volume (in MB/sec) appears also on the bottom-right of the status bar of
each main view.

Configuration

The configuration of the library is displayed.

Number of drives

The number of tape drives defined for this library.
Number of slots

The number of internal slots defined for this library.
Number of import/export slots

The number of import/export slots defined for this library.
Number of cartridges

The number of cartridges defined for this library.

The administrator can click the Edit button to modify the number of tape drives
and/or slots. See Changing the library configuration on page 9-11. (For
unauthorized users, this button is disabled.)

2 ¢ o B T

Edit
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Version information

Library version

The version of the library.
Click this button to display the Fixes dialog. The version number of the patch is

‘ Shcw fixss | displayed with the list of fixes contained within the patch.

9-6 Displaying the library configuration

Oracle Ex. 1226, pg. 110
Oracle, et al. vs. Crossroads

IPR2014-01207



Diligent Technologies
User Guide and Reference

Creating a new library

Before an appliance can be used by the backup application, there must be a
repository and at least one VTLU library on the disk arrays.

If there are unused file systems on an appliance, you can increase the capacity of the
repository. If the repository capacity allows, you can create additional libraries on
the repository.

A library’s definition can be modified later. See "Changing the library
configuration" on page 9-11. and Adding cartridges to a library on

page 9-19.

By default, a library is created with the number of internal slots equal to the number
of cartridges, and with no import/export slots. You can change the number of
internal slots and import/export slots in the library. See "Changing the library
configuration" on page 9-11..

E 1. To create a library on a repository, select repository in the navigation pane.

——. | 2. Choose Library > Create new library to invoke the Create new library
E wizard.

Welcome

The storage devices are queried to make sure that a new library can be created:

o the total number of tape drives defined on all libraries of the appliance must be
less than the maximum allowed number.

o Ifthere is not enough space to create a library, or if no additional drives can be
defined, you will not be allowed to create a library.

earth.diligent.com : Create new library ) El
DILIGENT /S TIER
_ 7 : rotec
| Create new ibrary rrrer—
v Welcome This wizard wil guide you in cresting & new lbrary on this applance

Library detads

Tape drives

Cartridges

Repart

1:_- Einish |;a'»:cl.
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Library name and robot visibility

Specify a name for the new library, and how the robot of the library is to be viewed

by the backup application.

earth.diligent.com : Create new library

X
ProtecTIER

Create new libr. r ~
el Library name |
 Wekame Choose a nasme Far this lbeary,
Library details
il ProtecTIER VT name: Fuaecl:cl
Tape drives
L
Cartridges
Robot [
Report
Chaoss the port on which the backup appiication will view the robat
Wi robok from aarth. dibgent com Robot port rumber |1 | vF
[sew )i ) [ oon |[oows |

Library name

The name you choose will appear on the navigation pane to identify the library.

Robot port number

Choose the front-end port through which the backup application will view the robot.
The wizard will only allow you to choose a port that is defined as a front-end port.

Tape drives

Specify the number of tape drives, and the front-end ports to which tape drives will

be assigned.

DILIGENT

3]

ProtecTIER

Create new library

« Welcome

« Library details
Tape drives
Cartridges

Report

Tape drives and ports assignment

tape drives per system is imited by the lcense,

Numier of tape drives (Max 118)

Specify the nuember of tape drives, and assign drives to front-end poets. Madmuen number of

Aready assigned: 0

[ Port 0 [ Wiwhi= 10000000c5210850]

Nuriber of drives: [0 E‘

Select Al | [Equaly dwide | [Ciear |

ey [ Ersh [ goncel
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Number of tape drives
Specify the total number of tape drives to be assigned for this library.

You cannot exceed the number of tape drives allowed for each appliance. If the
appliance has other libraries attached, a reduced number of tape drives can be
defined for this library.

Ports

Select the front-end ports to which tape drives should be mapped. For each port,
specify how many drives should be defined on this port.

Click Equally divide if you want to distribute the drives evenly among the selected
ports.

Cartridges

The virtual tape cartridges that will be used to store backup data are defined on the
repository. You can define additional cartridges later. See Adding cartridges to
a library on page 9-19.

The number of cartridges allowed is limited both by licensing restrictions and
available storage space.

panter. diligent.com : Create new library El
Creats libsr = =
reate new ibrary = |
s Choosa th of cartridges to creats, The number of cartridges aliowed is lmited both
+ Library details by boes ris, and avallable storage space. Barcode seed may anly inchade dighs
and upper lettars,
+ Tape drives
Cartridges No, of caetridges (Max, 127) [l | Virtual cartridge siee: 551 | GB
Report O M th | [~lce
Barcode seed 000913
[ Hep | AFrey E carcel |

No. of cartridges

The number of cartridges defined for the library.

Max. cartridge growth

By default, due to the effect of HyperFactor operations, a cartridge might end up
containing significantly more data than its nominal size.

To limit the amount of user data a cartridge can contain, you can set this option.
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Barcode seed

On defining a new library, you will be prompted to input the full barcode of the
initial cartridge. In each field, you may input either a number 0-9 or uppercase
letters A-Z. Following the setting of the seed, the barcode number will sequence in
ascending order from the seed barcode.

Barcodes with decimal number characters will increase numerically. Barcodes with
uppercase letter characters will increase alphabetically.

Virtual cartridge size

The virtual size of the cartridge.

The virtual cartridge size is an approximation of the user data the cartridge can
contain, taking into consideration the Hyperfactor effects.

Report
The summary report lists the configuration that will be defined for the library.
earth, diligent.com : Create new library E|
DILIGENT ProtecTIER
Create new library "si;nmaf rennt‘l 7
 wekome ProtecTIER VT ProtecLib vl be crasted with the folowing properties:
+ Lheary dotads & 200 Cartridges
+ Tapg drives Barcode seed set to 000000
o Cartridoss Unilmited cartridge growth se
v Report @  8tape drives
4 tape drives assigned to port 1 on server earth.diligent.com
4 tape drives assigned to port 3 on server earth.diligent.com
§  Robotis assigned to port 1 on server earth.diligent.com
[ Heip | | agrev || nesty | | Ersn |
Finish

Click Finish to exit the wizard. The library is created. This process requires some
time. A progress window shows the progress of the operation.

The new library is listed in the navigation pane.

9-10 Creating a new library

Oracle Ex. 1226, pg. 114
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
User Guide and Reference

Changing the library configuration

You can change the number of tape drives, internal slots, and import/export slots in

an existing library.

The administrator can invoke the Change dimensions wizard by clicking the Edit

button in the library configuration or via the Library menu. See Configuration on

page 9-5.

ﬂ 1. Select a library in the navigation pane.

2. Choose Library > Change dimensions to invoke the Change dimensions

wizard.

Welcome

By default, a library is created with the number of internal slots equal to the number
of cartridges, and with no import/export slots. You can use this wizard to change
the default settings.

X
ProtecTIER

goofy. diligent.com : Change dimensions

[changedimensions | [ ———— — —
' Welcome

Welcome This wizsed wil guide you in changing the number of tape drives, internal sioks and

Robot Impoatfeport siots in the bbrary, Please note that reducing the numbsr of drives might cause

a change In the port and LUN of the remained drives.
Drives

Slots

Report

apro || Boaty | | Foen || Concel
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Robot

Choose the port on which the backup application will view the robot.

goofy. diligent.com : Change dimensions

DILIGENT ProtecTIER
Change dimensions b .
¥ Welcome Choose the port on which the backup application wil view the robot.
;::: view robot from goofy. dilgent..com Robok port nurmber |""_D:
Slats
Repaort:

[aerer J[Hexr ] [nen [ conel |

Drives

Modify the number of drives and port assignments.

3]

goofy. diligent.com : Change dimensions

DILIGENT ProtecTIER
Change dimensions | | (. ity mumber of drives and ports assignments
el Nussber of Laps drives (Max 128) Fal Already assgned: 5
 Bobat
e HAPort 0 [ WWh= 10000000c5216850]  Numbsr of drives: m
Sots
Repart

[Track changes | [Seiect 1| [Equaly dwide ] [ciear

[eew (557

Number of tape drives
Specify the total number of tape drives for the library.

You cannot exceed the number of tape drives allowed for each appliance. If the
appliance has other libraries attached, a reduced number of tape drives can be
defined for this library.

Ports

You can specify which ports to use for the virtual tape drives.
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The wizard displays the current configuration. All front-end ports are listed. The
ports that are currently used for tape drive assignments have a check in their check
box.

By checking or un-checking the check boxes, you can change the ports to which
tapes are assigned. Choose the number of tape drives to be assigned to each port.
Any change that you make to the front-end port selection might affect the LUNs of
the drives. If a drive is re-assigned to the same port as before, the LUN doesn't
change. So ProtecTIER first tries to assign a drive to the same port to which it was
assigned before, and then distributes the remaining drives equally among the other
selected ports.

[Track Chenges You can evaluate the effect of a particular change in ports, by clicking the Track
changes button after you have checked or unchecked boxes. ProtecTIER displays
a report listing which drives might get a new LUN because they are assigned to a
new port.

(Equaly dvide I:C’él:l:;( Equally divide if you want to distribute the drives evenly among the selected

Slots and import/export slots

Define the number of slots you want to define for the library. By default, a library
is created with the number of internal slots equal to the number of cartridges, and
with no import/export slots. You can use this wizard to change the default settings.

X
ProtecTIER
Change dimensions [Stots
 Yekome Specly the rurmber of internal slots snd importfexport skots,
+ Bobot
+ Drives Number of slots (Max 8152) =
Bl Nuber of inportjexport dots (Mac4056) [0 F
Report
[ Hep | | aprew || nostr | | Even || concsl |

Number of slots

Specify how many internal slots you want to have in this library. A library must
have at least as many slots as cartridges.

Number of import/export slots

Specify how many import/export slots you want to have in this library.
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Report
The summary report lists the number of slots and tape drives that will be defined for
the library.
goofly. diligent.com : Change dimensions E|
DILIGENT ProtecTIER
thuwe Sesisions [ Summary report
 Wekome Library Lib1: No changes have been made to the lbrary dimensions.
+ Robot
 Drives
¥ Slots.
¥ Report
If you have gone through the steps of the task without changing any definitions, you
receive the following message:
Summary repork
Library A: Mo changes have been made to the library dimensions,
The Finish button is not enabled. You can go back to the Drives and slots step
and modify the dimensions, or you can cancel the wizard.
Finish

Click Finish to exit the wizard. The library is changed according to your
specifications.
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Re-assignhing robots and drives to ports

You can decide which ports to use for the library’s robot, and which ports to use for
the library’s tape drives.

1. Select a library in the navigation pane.

2. Choose Library > Re-assign devices to invoke the Re-assign devices
wizard.

Welcome

goofy. diligent.com : Re-assign devices

X

Re-assign devices Cicome. |
Welcome This wezaed vl guide you in changing the assignments of the devices to the front-end ports
Robot Please note that  a drive is re-assigned a new port, s LUN & not guarantesd bo stay the
sam
Re-assign Ports )
Report
| Help | aprav || Mot | | ¢ | concel |

Robot

Specify how the robot is to be viewed by the backup application.

goofy. diligent.com : Re-assign devices |'S?|

DILIGENT #& : ProtecTIER

Re-assign devices
= Robot |
i = Chose the port on which the bisckup apphcation vl visw the rabat
Robot —
View robet from goofy, diigent..com Robot port number [0 u
Re-assign Ports -
Report

| qprev | [ Ersh |[ gancel
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Robot port number

Choose the front-end port through which the backup application will view the robot.
The wizard will only allow you to choose a port that is defined as a front-end port.

Re-assign ports
You can specify which ports to use for the virtual tape drives.

The wizard displays the current configuration. All front-end ports are listed. The
ports that are currently used for tape drive assignments have a check in their check
box.

By checking or un-checking the check boxes, you can change the ports to which
tapes are assigned. Choose the number of tape drives to be assigned to each port.

Any change that you make to the front-end port selection might affect the LUNSs of
the drives. If a drive is re-assigned to the same port as before, the LUN doesn't
change. So ProtecTIER first tries to assign a drive to the same port to which it was
assigned before, and then distributes the remaining drives equally among the other
selected ports.

gooly. ditigent.com : pvices El
SEERSLIN AN (¢ - ProtecTIER

Re-assign devices

| Assign Ports

b Wﬂﬂi
 Rabot

Re-assign Ports

Number of tape drives |5 5| Already assigned: 5

FAPort 0 [ Wh= 10000000c5216850]  Number of drives: |6 E‘

Report

Track Changes | [Select At [Equaty dvide | [dear]

[ veip | |¥e\‘_H et b | | ot || Cancel |

— Click Equally divide if you want to distribute the drives evenly among the selected
] Equally divide ports

|ml You can evaluate the effect of a particular change in ports, by clicking the Track
changes button after you have checked or unchecked boxes. ProtecTIER displays
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a report listing which drives might get a new LUN because they are assigned to a
new port.

Samuell : Re-assign devices

DILIGENT

ProtecTIER

Re-assign devices
e | Assign Ports
etk Wumber of tape drives [0 ||  Abeady assigned: 8
+ fopliances
Acdw:ene»{a! jl
v Bobot
Drive 3 LU might: be changed
R Port:
Eiasiun Lo Drive 4 LUN might be changed
Report

Drive 5 LUN might be changed

[er) [ o

Report

The summary report lists the new device assignments.

goofy. dilipent.com : Re-assign devices

x|
DILIGENT ProtecTIER
Re-assign devices [Summary report

Library Lib1 :No changes have been made to the ports assgnments
+ Re-assign Ports

+ Report

Finish

Click Finish to exit the wizard.
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Deleting a library

You can delete a library from the repository. The space occupied by the cartridges
of the library is made available, and can be added to other libraries.

Important

If'there is data on the cartridges of the library, this data is lost. No recovery is
possible.

H 1. Inthe navigation pane, select the library that you wish to delete.

2. Select Library > Delete library.
You are warned that the library data will be destroyed.
If you wish to delete the library and its data, confirm the action.

Delete Library ] x|

,7 You are abouk to delete the fibrary,
"; | All cartridges data will be lost,
* Do you want to delete the library ?

3. To make sure that you intend to delete the library, and that you understand that
any data contained in this library will be lost, you are asked to verify that this is
your intention.

Confirm data loss

Please confirm repository
removal by typing ‘data loss'

L 1
|O__k| | Cancel

Type the phrase data /oss if you wish to delete the library. No other phrase will
be accepted.
If you do not want to delete this library, click Cancel.
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Adding cartridges to a library

If there is space on the repository, you can add cartridges to an existing library.

When you add cartridges, the number of internal slots is automatically increased, if
necessary, so that there are at least as many slots as cartridges.

n 1. Select a library in the navigation pane.

2. Select Library > Add cartridges to invoke the Add cartridges wizard.

\.c -
Welcome
The repository is queried to make sure there is enough space to add cartridges.
Ifthere is not enough space to add cartridges to a library, you will not be allowed
to add any.
goofy. diligent.com : Add cartridges
DILIGENT
T — ,
Welcome This wizard will guide you in adding new cartridges to an existing lbrary.
4 Brev W | Enish [] Cancel
Cartridges
The virtual tape cartridges that will be used to store backup data are defined on the

repository.
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The number of cartridges allowed is limited both by licensing restrictions and
available storage space.

goofly. diligent.com : Add cartridges

DILIGENT & ProtecTIER

Add cartri - _ ;
diges Cartridges |
 Welcome . " |
: of cartridges to create, The number of cartridges allowed is mited both
Cartridges by be ions, and avaisble storage space. Barcode ssed may only inchude digls.
and uy
Report
No. of cartridges (Max. 203) (11 | wirtual cartridge size: GB
[ Max. cartridge growth | T=lcs

Barcade seed [oo007

[aprev [ty | [ Enen |[ goneel |

No. of cartridges
The number of cartridges defined for the library.

Max. cartridge growth

By default, due to the effect of HyperFactor operations, a cartridge might end up
containing significantly more data than its nominal size.

To limit the amount of user data a cartridge can contain, you can set this option.

Barcode seed

On defining a new library, you will be prompted to input the full barcode of the
initial cartridge. In each field, you may input either a number 0-9 or uppercase
letters A-Z. Following the setting of the seed, the barcode number will sequence in
ascending order from the seed barcode.

Barcodes with decimal number characters will increase numerically. Barcodes with
uppercase letter characters will increase alphabetically.

Virtual cartridge size
The virtual size of the cartridge.

The virtual cartridge size is an approximation of the user data the cartridge can
contain, taking into consideration the Hyperfactor effects.
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The summary report tells you how many cartridges will be added.

goofy. diligent.com : Add cartridges

DILIGENT

3
ProtecTIER

Add cartridges

« Welcome

« Cartridges

+ Report

Summary report
No cartridges vl be added to Library Lib1

sz e | [ ]

Finish

Click Finish to add the cartridges and exit the wizard.
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Checking a library

You can perform an integrity check on a library, if you suspect that the data has
become corrupted.

When to check a library

Check a library in the following cases:

o

the library name is listed in the navigation pane with question marks around the

name; for example, Library (?A?)

o youreceive the message Cannot find file system(s)

o cartridges are listed in red on the display

o no data is listed for a cartridge

How to check a library

H 1. Select a library in the navigation pane.
2. Select Library > Check library.

Check library

D

The table displays a list of damaged cartridges, Select a corrective action to perfom on each cartridge and hit the Fixc all
button to fix the cartridges. Press the continue button to continue,

d cartridges

Barcode

]Action

|Err0r

000020

000027

Select B Cartridge meta data corrupted, need to recover

Eelect ,T Cartridge meta data corrupted, need to recover

Select
Recover
Format
Delete

| wEix |

@ Cancel

If there are problems with the library cartridges, a table is displayed with a list

of damaged cartridges.

Select an action to perform on each cartridge and press Fix to fix the cartridges.
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Click OK to continue.
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Resetting the robot

You can perform a SCSI reset of a robot.
1. Select a library in the navigation pane.
2. Choose Library > Reset robot.

3. Confirm the action.
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Managing library components|1 0

You can display information about the tape drives, internal slots,
import/export slots and cartridges in a library.

You can unload a tape drive, and move a cartridge from one slot or
drive to another, and provide other actions.

R BTVIBI g S BERBABE . « « o e v v v iee s iia et 10-2
Displaying tape drives. . ..., 10-3
Performing tape driveactions . . ........................ 10-5
Displayingslots. ........... ... ... .. ... 10-7
Performing slotactions .. .............. ... ... ........ 10-9
Displaying import/exportslots . ....................... 10-11
Performing import/export slot actions. . ................. 10-12
Displaying cartridges. . . ... .. 10-14
Performing cartridge actions. . . ............ ... ... ..... 10-15
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Overview

When you select a component under the library node in the navigation pane,
information is displayed in the work pane.

Sorting columns

To sort by a column of the display, click on the column header. The triangle
indicates whether the column is sorted in ascending order or descending order.

Scrolling through a list of components

Up to 23 components can be listed on the ProtecTIER display at one time. Tape
drives are all shown at one time.

In order to scroll to view other components, use the buttons appearing at the top of
the display.

Examples are given here for displaying the cartridges of a library, but the library’s
tape drives, internal slots and import/export slots are displayed in the same way.
For the cartridge display, the scroll controls appear as shown.

It indicates which components are currently displayed, and the total number of
components.

Cartridges 92- 114 of 468 |E| | 4 Prev Cartridges | | Next Cartridges b | |E| Go to Cartridge | ___

You can scroll to the next or previous groups of components, or you can jump to the
first 23 or the last 23, or you can jump to a particular component.

I@ Scroll to display the next group of components.

]@ Scroll to display the previous group of components.

|E] Jump to the last group of components.
|m Jump to the first group of components.

Gotocartrdge [ | [0 TO jump to a particular component, type the sequence number of the component in
the box and click the Go button. A screen with a group of components is displayed,
with the requested component at the top.

10-2 Overview
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Displaying tape drives

Expand a library node in the navigation pane. Four nodes appear under the library
E node: Drives, Slots, ImpExp and Cartridges.

Select the Drives node to display a list of tape drives defined for this library.

fif

{68l ProtecTIER Manager

Fée Appliance Repository HypetFactor  PaokecTIER YT  Wiew Recovery Took Help

Eb L[i) Applisnce *3 L .}5 1 |4 Library ‘&E Cartridges ﬁ':, -{_}': @
B Lo (== ProtecTIER VT ProtecTIER_1 : Drives
g I;?‘::EC:JYEP\" N s 1o gofe 4| [4Prev Driv e Drives b | [M]  Gotoorive [ | [Go
7 B Configuration
S || [oivetie, Tionisd Tverviotime [rrodutiane [rovion _[port [t [Adbess [smeoie
L& Cartricges]| [° = QUANTLIM DLT7000 0100 1 1 BEBESE
LM jaguar.digent com 1 QUANTLM DLT7000 0100 3 2 17
2 QUANTLM CLT7000 0100 3 3 18
3 QUANTLM DLTT000 0100 3 4 19
4 QUANTLM DLT7000 0100 3 5 20
5 QUANTLIM [LT7000 0100 3 [ 21
6 QUANTLM DLT7000 0100 3 7 2
7 QUANTLM CLT7000 0100 3 8 2
F Library
el The library is identified.
Configuration
For each tape drive, the following information is displayed:
Drive No.
The index of the tape drive within the library.
Loaded
A drive icon with a cartridge inside indicates that the drive contains a cartridge and
is loaded.
A drive icon with a red X indicates that the drive contains a cartridge and is not
loaded.

If there is no cartridge in a drive, this column is blank.

Vendor Name

The tape drive behaves like a tape drive from this vendor.

This information about the tape drive is returned to the host as a response to the
SCSI INQUIRY command.

Managing library components 10-3

Oracle Ex. 1226, pg. 131
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
ProtecTIER

Product Name

The tape drive behaves like a tape drive of this product type.

This information about the tape drive is returned to the host as a response to the
SCSI INQUIRY command.

Revision

The tape drive behaves like a tape drive of this revision number.

This information about the tape drive is returned to the host as a response to the
SCSI INQUIRY command.

Port
The front-end port to which this drive is assigned.

LUN
The LUN of this tape drive with respect to this port.

Barcode

If there is a cartridge in the drive, this is the barcode of the cartridge. If there is no
cartridge in the drive, this is blank.

Offline drives

When a virtual tape drive is not assigned to any port, it is in an offline state. The
offline drive appears in a different color. Any cartridge in an offline drive is
automatically unloaded.

The tape drive remains offline until it is explicitly assigned to another front-end
port.
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Performing tape drive actions

7 Important

Do not perform these operations while the backup application is using the library.

Doing so may damage the operations of the backup applica

tion.

When a list of tape drives is displayed, you can right-click on a drive in the list, to

access a right-click menu. You can reset the drive. If the dri
you can unload or move the cartridge.

ve contains a cartridge,

Reset drive and Unload drive are also available in the Drive menu.

Resetting a tape drive
You can perform a SCSI reset of a tape drive.
1. Right-click on a drive in the list.
2. Choose Reset drive from a right-click menu.
3. Confirm the action.

x

£ 'You are about to reset the selected drive.
"__:J Are you sure you want to reset the

| i drive 7
[ree] 1]

Unloading a tape drive

1. Right-click on a full loaded drive in the list.
2. Choose Unload drive from a right-click menu.

Moving cartridges from a tape drive

Before you can move cartridges from a tape drive, you must
1. Right-click on the cartridge you want to move.

unload them.

2. Choose Move cartridge from the menu. The Move Cartridge dialog is

displayed.

Managing li
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To move multiple cartridges at a time, select drives by pressing <Shift> & lefi-
click. Without releasing the <Shift> button, right-click and select Move
cartridges from the menu.

Move cartridge E]

Mowe 8 cartridges from slots

Destination Type E1Dl |E]

Destination
(@) Next Avaiable
O slot No. ' ]

Destination type Inthe Destination type box, choose Drive, Slot or
Import/Export.

Destination Ifyou have chosen to move the cartridge to a drive, choose the
number of the drive. If you have chosen to move the cartridge to a slot, you can
specify the slot number, or you can have the cartridge moved to the next available
slot.

If you choose to move more than one cartridge, the cartridges will be moved in a sequential
order, starting with specified destination. Make sure the required number of continuous
destination components is free.

10-6 Performing tape drive actions
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Displaying slots

E When you expand a library node, four nodes appear under the library node: Drives,

Slots, ImpExp and Cartridges.

library (not including import/export slots).

H Select the S/ots node to display a list of internal cartridge slots defined for this

lol ProtecTIER Manager

Fle Applance Reposkory ProtecTIER VT  View Recovery

B B o 40 5 B

Todls _telp

ubrory S cotriooes > e | [B)

F Library
Sl The library is identified.

Configuration

=¥ nema. dligent. com || s
E-§) Repostory ProtecTIER VT lib_final_test : Slots
- TIER VT (i} — = =
. o Slots  1- 23of 32 i (4 | Mext Slots b | | ¥ | GotoSkt | ] | Go
- L Configuration z - -
'r’"'l"“ | Slot No. | Address Barcode | Capacky(MB) | Daka Size (M8)

A L 1040 112233 50688 w2

1 1041 11223 50689 2662

1042 112235 50583 22

43 11223 50668 32882

4 1044 112237 50688 3652

145 112238 50688 2882

1046 112239 50688 32682

For each slot, the following information is displayed:

Slot No.

The index of the slot within the library.

Address

The element address of the slot within the library.

Barcode

If there is a cartridge in the slot, this is the barcode of the cartridge. If there is no

cartridge in the slot, this is blank.

Capacity (MB)

If there is a cartridge in the slot, this is the capacity of the cartridge. If there is no

cartridge in the slot, this is blank.
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Data size (MB)

If there is a cartridge in the slot, this is the nominal size of the user data on this
cartridge. If there is no cartridge in the slot, this is blank.

10-8 Displaying slots
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Performing slot actions

When a list of slots is displayed, you can right-click on a slot in the list, to access a
right-click menu. If the slot contains a cartridge, you can move the cartridge or
change its read/write setting.

These options are also available from the Cartridges menu.

Moving a cartridge

1. Right-click on the cartridge you want to move.

If you want to move more than one cartridge, press <Shift> & left-click to select
cartridges, then <Shift> & right-click on the cartridges you want to move.

2. Choose Move cartridge from the right-click menu. The Move Cartridge
dialog is displayed.

Move cartridge x|

Move cartridge UADDO4 from slot 3

Destination Type [ZI
Destination
@ Next Available
C Slot No. | |

B

Destination type Inthe Destination type box, choose Drive, Slot or
Import/Export.

Destination Ifyou have chosen to move the cartridge to a drive, choose the
number of the drive. If you have chosen to move the cartridge to a slot, you can
specify the slot number, or you can have the cartridge moved to the next available
slot.

If you choose to move more than one cartridge, the cartridges will be moved in a sequential
order, starting with specified destination. Make sure the required number of continuous
destination components is free.

Changing the read/write mode of a cartridge

When a cartridge resides in a slot or an import/export slot, you can toggle its
read/write mode between read-only and read/write. When the cartridge is located
in a tape drive, its read/write mode cannot be changed.

1. Right-click on the cartridge whose read/write mode you want to change.
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2. Choose Read/write cartridge from the right-click menu.
3. Confirm the action.

Read/Write cartridge

, Jetting the cartridge to read-only,
Do youwant to continue?
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Displaying import/export slots

When you expand a library node, four nodes appear under the library node: Drives,
E Slots, ImpExp and Cartridges.

for this library.

ﬂ Select the Imp/Exp node to display a list of import/export cartridge slots defined

[6] ProtecTIER Manager

Fle Applance Fepostory ProtecTIER YT  View Recovery Took Help

i t) " b wary Bl cartridoes T TN
[k i\ Appliance o5 H& .| 4 Libsrary _& Cortridges £ - @
IB ProtecTIER VT lib_final_test : ImportExports
ImportExports  0- Oof O 4] [« 1 " v ¥ G0 to ImportExport Go
|_Configuration . ) —
+ ImpjExp...| Address | Barcode | Capacky(MB) | Data Size (MB)

& Cartridges

For each import/export slot, the following information is displayed:

Imp/Exp No.
The index of the import/export slot within the library.

Address

The element address of the import/export slot within the library.

Barcode

If there is a cartridge in the import/export slot, this is the barcode of the cartridge.
If there is no cartridge in the import/export slot, this is blank.

Capacity (MB)
If there is a cartridge in the import/export slot, this is the capacity of the cartridge.
If there is no cartridge in the slot, this is blank.

Data size (MB)

If there is a cartridge in the import/export slot, this is the nominal size of the user
data on this cartridge. If there is no cartridge in the slot, this is blank.
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Performing import/export slot actions

When a list of import/export slots is displayed, you can right-click on a slot in the
list to access a right-click menu. If the slot contains a cartridge, you can move the
cartridge, change its read/write setting, or rebarcode.

Moving a cartridge

1. Right-click on the cartridge you want to move.

If you want to move more than one cartridge, press <Shifi> & lefi-click to select
cartridges, then <Shift> & right-click on the cartridges you want to move.

2. Choose Move cartridge from the right-click menu. The Move Cartridge
dialog is displayed.

Move cartridge [ |

Movwve cartridge UADOD4 from slot 3

Destination Type lz‘
Destination
® Mext Available
O Slat Mo

|E Cancel

Destination type In the Destination type box, choose Drive, Slot or
Import/Export.

Destination Ifyou have chosen to move the cartridge to a drive, choose the
number of the drive. If you have chosen to move the cartridge to a slot, you can
specify the slot number, or you can have the cartridge moved to the next available
slot.

If you choose to move more than one cartridge, the cartridges will be moved in a sequential
order, starting with specified destination. Make sure the required number of continuous
destination components is free.

Changing the read/write mode of a cartridge

When a cartridge resides in a slot or an import/export slot, you can toggle its
read/write mode between read-only and read/write. When the cartridge is located
in a tape drive, its read/write mode cannot be changed.

1. Right-click on the cartridge whose read/write mode you want to change.

10-12 Performing import/export slot actions
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2. Choose Read/write cartridge from the right-click menu.
3. Confirm the action.

Read/Write cartridge

y, Setting the cartridge to read-only.
- Do you want to continue?

Rebarcoding a cartridge

You can change the barcode of an existing cartridge to a new barcode that you
specify. ProtecTIER does not allow the new barcode to duplicate an existing
cartridge. Only cartridges residing in a library Imp/Exp slot can be re-barcoded.

ProtecTIER will not allow the definition of a barcode that starts with the prefix CLN.

To rebarcode a cartridge:

1. Right-click on the import/export slot and select Rebarcode. The Rebarcode
dialog is displayed:

Rebarcode

Reborcode: [ ] ‘
|-'-I | |Cancel

2. Enter the new barcode and click OK.
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Displaying cartridges

When you expand a library node, four nodes appear under the library node: Drives,
Slots, ImpExp and Cartridges.

E! Select the Cartridges node to display a list of cartridges defined for this library.

6] ProtecTIER Manager
Fie opplance Repostory ProtecTERVI View Recovery Took Help

[};U Aophance oF] < B (B o] | F |uiwory BB contridges G R @

R nema.diigent. com
= oy ProtecTIER VT lib_final_test : Cartridges
=~ ProtecTIER T (b et (s L —
!‘ Drives Cartridges  1- 230f 32 1 g | Mest Cartridges » | :_>|_| Go to Cartridge | | Go
hmt | Configuration I | " - — [

| Barcode | Wrke enabled | Capacty (MB) | Daka Size (M)

""@ |112233 v 50658 2682
112234 v 50688 32682
112235 v 50688 32682
11223 L 50658 eea
112237 v 50688 32682
12238 v 50688 k-
112239 v S0688 32682
112240 v 50688 32642
l11z201 o 50688 1644

For each cartridge, the following information is displayed:

Barcode
The cartridge label.

Write enabled

This column contains a green check mark if the cartridge is available for write
access.

Capacity (MB)
The storage capacity of the cartridge.

Data size (MB)

The nominal size of the user data on this cartridge.
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Performing cartridge actions

When a list of cartridges is displayed, you can right-click on a cartridge in the list to
access a right-click menu. These option are also available from the Cartridge
menu.

Deleting a cartridge

1. Right-click on the cartridge you want to delete.

If you want to delete more than one cartridge, press <Shift> & lefi-click to select
cartridges, then <Shift> & right-click on the cartridges you want to delete.

2. Choose Delete cartridges from the right-click menu. The Delete cartridges
dialog is displayed.

Delete Cartridge

Pt You are about to delete cartridge 000002,
E}- Data will be lost.
Do you want to continue?

[res] ]

3. Click Yes to execute the Delete cartridges operation. The Confirm data loss
dialog is displayed.

Confirm data loss

Please confirm cartridge
erasing by typing 'data loss"

1
|E| | Cancel

4. Type data loss and click OK. The cartridge is deleted from the list in the work
pane.
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Check cartridge integrity
You can verify cartridge data integrity.
1. Right-click on the cartridge whose data integrity you want to check.
2. Choose Check cartridge integrity from the right-click menu. The Check
cartridge integrity dialog is displayed.

This operation will verify cartridge data
@_ integrity. It might take some time to
. complete,
Continue?

e o]
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Recovering ProtecTIER |1 1

After a crash (e.g. power failure, fatal system error, or hardware
failure), while the last operation may not have successfully completed,
the system must return to an operational state.

A basic consistency check will be done every time the system comes
up. If the system is found or suspected to be corrupt, you will be
prompted to execute checks and recovery elements in respect to the
damage found.

Performing recovery operations ........................ 11-2
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Performing recovery operations

Recovery operations are generally performed by either Customer Service Support
representatives or administrators only.

System check

If the system is found to be corrupt, you will be prompted to execute checks and
recovery elements in respect to the damage found.

To run the system check operation, choose System check from the Recovery
menu. Click Recover.

One module at a time is checked. If errors are found in a module, the system check
will stop checking the other modules until the errors of the respective module are
fixed. All of the errors displayed belong to the respective module currently being
checked.

mir.diligent.com : system check 1N x|

System check summary

[ An error has affected Dfs own files. Correction is
mandatory, but time consuming.

Stm needs file recovery

[\f Recover | Cancel

Only when the problems pertain to the DI'S module can you choose which errors to fix.

If you do not select all the errors from the list to fix, you will be prompted again to
fix any remaining errors.

mir.diligent.com : Recover repository x|

Mot all errors were fixed. In some cases, retry could

@\ solve these issues.
)

Do you want to view and fix remained issues?

Click Yes to view the remaining errors of that module. Once all of the module errors
have been fixed, a System check summary dialog is displayed to rerun the
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system check on the remaining modules (i.e. other than DFS). The appearing errors
will be automatically selected for recovery and cannot be de-selected.

Click Recover to rerun the system check.

mir.diligent.com : system check il

System check summary

An error was detected in one of the cartridge manager
files. Run recovery on cartridge manager.

Once the system check operation completes, you can rerun the operation to verify
that there are no additional errors.

Click Yes to rerun the system check operation.

System check x|

System check completed successfully, all of

the selected errors have been fixed. Itis

recommended to run the system check
@ again, to verify no further errors

encountered.

Rerun system check?

If no errors are found, a message is displayed that the system check completed
successfully.

mir.diligent.com : System check _Z]

e_ System check completed successfully. No
=

errors found,
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PART THREE - ProtecTIER Mgr Admin

These chapters describe managing user files, how to access
the event log and error log, and troubleshooting.

PART THREE - ProtecTIER Mgr Admin 1
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Manager Logs & Troubleshooting |1 2

As a user works with ProtecTIER Manager, warnings and error
messages are written to a log file. There may be situations where
Technical Support will ask you to examine this file or to forward it to

them.
ProtecTIER Manageruserfiles......................... 12-2
Testing and troubleshooting .. ......................... 12-3
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ProtecTIER Manager user files

Log files and configuration files are saved for each user, identified by the username
of the user on the network.

work.<username> directory

For each user who has invoked ProtecTIER Manager, a subdirectory is created in
the directory in which ProtecTIER Manager is installed, named work.<username>
where <username> is the name under which the user logged in to the network.

This directory contains a configuration file for the user, named gui.cfg and log files.

This file stores definitions made during the user session, so that the user’s
environment is preserved for the next time this user invokes ProtecTIER Manager.

manager.log files

As a user works with ProtecTIER Manager, warnings and error messages are
written to a log file. There mayv be situations where Technical Support will ask you
to examine this file or to forward it to them.

Messages written to the log file report on conditions that are local to ProtecTIER
Manager, as well as conditions that apply to ProtecTIER.

The log file is stored in the work.<username> directory.

Log file name
The name of the file is manager<x>.log.
Current log is manager(.log.

Backup log files

The log file can be up to 10MB in size. When the size of the file reaches this limit,
the current log file is copied to a backup file.

Up to three backup versions of the log file are saved in the log folder. They are
named managerl.log, manager2.log and manager3.log.

When the current log file reaches the maximum size, the oldest backup copy is
overwritten, in a cyclic manner.
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Testing and troubleshooting

After installing ProtecTIER Manager, test to make sure that it has been installed
properly.
You must have a ProtecTIER appliance running.

Provide appliance connection properties
1. Invoke ProtecTIER Manager. ProtecTIER Manager will attempt to scan the
TCP/IP network for REO 9500D appliances.

2. Ifno appliances are auto-detected, supply the TCP/IP subnets to be scanned, as
described in Auto-discovery of appliances on page 7-3. Or, add appliance
properties manually.

Log in to the appliance

1. Right-click on the node of the appliance in the navigation pane. Choose Login.

2. Inthe Login dialog, provide a username and password that are valid on the
appliance. Click Ok.

3. Browse the tree on the navigation pane at the left, and verify that the displayed
information reflects the appliance configuration.

Troubleshooting

If ProtecTIER Manager cannot find the appliance, try to resolve the problem by one
of these methods:

o make sure that you can ping the REO 9500D platform
o try to use the IP address instead of the DNS name
o make sure that there is no firewall between the computers

Manager Logs & Troubleshooting 12-3
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ProtecTIER logs 1 3

An event log and an error log can be displayed in ProtecTIER Manager.

Events that are logged

Displaying the Eventlog. ........ ... ... . ... ....... 13-2
................................ 13-3
Displaying the Errorlog . ........... ... .. .. ... .. .... 13-4
................................ 13-5

Errors that are logged
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Displaying the Event log

As users work with ProtecTIER via the ProtecTIER Manager client, events are

logged.

The event log contains an entry for each significant event. These are not errors, but
they can be used to understand what ProtecTIER was doing when an error occurred.

The event log also contains the errors that are listed in the error log. See
Displaying the Error log on page 13-4.

The event log can also be viewed by logging in to the ProtecTIER appliance and
using Unix tools to search, filter and view the contents of the log file
/fx_work0/log/vif_event.log.

Click the Event log button, when appliance properties are displayed, to display the
I Events Log | event log.

You can click on the column headers to sort the entries according to that column.

= Events Log

Current time on server: Sat Jul 10 23:41:06 IDT 2004
Date [Pid [Message
Jul 9 16:42:51 13795 The cluster member at 168,159.150,121 failed to respond to the cluster manager's request.
Jul 9 16:42:51 13795 Library check - operation completed successfully, E
Jul 9 16:42:51 27840 no event message
Jul 9 16:42:51 13795 Setting compression directive - operation completed successfully,
Jul 8 16:42:51 13795 The cluster member at 168,159,150,121 failed to respond to the cluster manager's request,
Jul 8 16:42:51 13795 Library check - operation completed successfully,
Jul 8 16:42:51 27840 no event message
Jul 8 16:42:51 13795 Setting compression directive - operation completed successfully,
Jul 8 16:41:08 i} message repeated 2 times
Jul 8 16:38:14 i} message repeated 2 times
Jul 8 16:38:14 13795 The cluster member at 168,159.150,121 failed to respond to the cluster manager's request.
Jul 8 16:38:13 13795 Library check - operation completed successfully,
Jul 8 16:38:12 13795 User vtfadmin logged in from AYIVCARO _XP at 192,168,108.58,
| Help | "4 Previous lines " |[-1e-r. lines b |
Date

The date and time at which the event was logged.

Pid

The ProtecTIER process ID of the message.

Message

The message describing the event.

13-2 Displaying the Event log
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Events that are logged

These types of events are logged:

o repository configuration (create, increase, delete)
o library configuration changes (create library, change configuration, add/delete
cartridges, set HyperFactor mode, delete library)

o change HyperFactor scheduling

o start and completion of a configuration change that takes more than one second
o ProtecTIER Manager logins

o automatic recovery, e.g. failover

o VTLU status checks

o link up and link down events

o lopology changes

o ProtecTIER going offline or online

o move media commands, with success or failure status, and a reason for failure,
including all mounts and dismounts

o failed SCSI command, with check condition (except the following: Illegal
Length Indication (ILI), Test Unit Ready that fails because of cartridge unloaded
or not present, end of media)

o Fiber Channel PLOGI events and initiator WWN
o login denied

o configuration session that timed out

o successful login (user name is logged)

o each signal that is encountered

o stopping ProtecTIER for configuration

o starting ProtecTIER

ProtecTIER logs 13-3
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Displaying the Error log

I Alerts I
Clear Alerts

As users work with ProtecTIER via the ProtecTIER Manager client, all errors are
logged.

The error log lists errors and illegal requests. When an error message has been
added to the error log, the Alerts button on the appliance properties display is
flashing.

Errors are problems or issues detected by ProtecTIER. Any event that may require
operator intervention is treated as an error.

Errors are also logged to the system message log.

Click the Alerts button, when appliance properties are displayed, to display the
error log.

The administrator can clear the list of errors (and stop the Alerts button from
flashing) by clicking Clear alerts.

% Alerts Log

| Current time on server: Sat Jul 10 23:42:39 IDT 2004

|Date [pid [Message
Jul 6 09:07:09 13795 Error: The storage already has cluster database devices., E
Jul 5 19:21:23 13795 Error: Could not find a copy of a cluster database.. |

5

-
|1 Previous lines | |?-J-5--r_ ines b | | Clear flerts

Date

The date and time at which the error was logged.
Pid

The ProtecTIER process ID of the message.

Message

The message describing the error.

13-4 Displaying the Error log
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Errors that are logged

These types of errors are logged:

o bugchecks

o reservation conflicts

o SCSIresets

o illegal SCSI commands

o 1/O failure

o Fiber Channel port failure

o license expiration, or license nearing expiration date
o API call that returns an erroneous return code

o ProtecTIER appliance going down unexpectedly

ProtecTIER logs 13-5
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Error messages 14

Messages listed here are generated by ProtecTIER.

ProtecTIER Manager error messages. .. ........... 14-2
Sense key information.......................... 14-3
Eventlogmessages .......... ... ... ... ... ... ... 14-6
Error logmessages. . ......... ... 14-13

Error messages 14-1

Oracle Ex. 1226, pg. 163
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
ProtecTIER

ProtecTIER Manager error messages

These five categories of error messages might be reported by ProtecTIER
Manager.

(eror X
| Close
0 #wthorization error,

| Details == J

Communication error

This indicates that the server was not found, or the ProtecTIER daemon
was not found.

Authorization error

Invalid username or password was provided, or user (administrator) was
logged out by a different user that logged in from another instance of the
application.

System error

An error occurred between the daemon and ProtecTIER Manager.

ProtecTIER error
An error has been returned by the ProtecTIER process.

Application error

This type of error is an internal ProtecTTER Manager error, and should
not occur. Contact Technical Support if the problem persists.

14-2 ProtecTIER Manager error messages
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Sense key information

These indicate an error or other condition in a ProtecTIER virtual
device. The sense key information is returned in the Sense Key field of
the SCSI Sense. Additional sense codes and qualifiers are listed.

Sense key 00: No Sense

No specific sense key to information to be reported. Indicates a
successful command that received a check condition status because of a
filemark, end-of-medium, or illegal length indication.

code qualifier description

00 00 No additional sense information

00 01 Unexpected File Mark encountered
00 02 End of medium detected

00 04 Beginning of medium detected

Sense key 02: No Ready

The addressed device is nat ready.

code qualifier description

04 02 Load command required
3A 00 Medium unloaded or not present

Sense key 03: Medium Error

Non-recoverable error condition. Might be caused by an error on the
media or in the recorded data.

code qualifier description

00 00 Medium error

0C 00 Write error

11 00 Non recoverable read error

15 02 Position error detected by read
3B 00 Sequential positioning error
3B 08 Reposition error

Error messages 14-3
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Sense key 04: Hardware Error

Non-recoverable hardware error detected by the device.

code
44

qualifier description

00

Internal target failure

Sense key 05: Illegal Request

Illegal parameter in the CDB or parameter data.

code
1A
20
21
24
24
26
26
26
3B
3B
53
80
82

qualifier description

00
00
01
00
89
00
01
02
0D
OE
00
01
00

Parameter list length error

Illegal Opcode

Invalid element address

Invalid field in CDB

Image data over limit

Invalid field in parameter list

Parameter List Error, parameter not supported
Parameter List Error, invalid parameter value
Media destination element full

Media source element empty

Media load or reject failed

Transfer full

Not allowed if not at BOT

Sense key 06: Unit Attention

Device was reset or changed.

code

29
80

qualifier description

00
00

Power on or reset occurred
Door was opened

Sense key 07: Data Protect

Attempt to write to a write-protected medium.

code
27

qualifier description

80

Unable to overwrite write protected data

14-4 Sense key information
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Sense key 08: Blank Check

The device encountered a blank medium.

code qualifier description
00 05 End-of-data encountered

Sense key 0D: Volume Overflow

A buffered device has reached end-of-tape and data remains in the
buffer.

code qualifier description
00 00 Volume overflow

Error messages 14-5
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Event log messages

| Events Log |

These messages are logged in the event log that is displayed when you
click the Event log button on the ProtecTIER Manager display.

Event messages may contain variable information. In the messages
listed below, variable information is enclosed in angle brackets.

System events

ID message in the event log explanation
1 A configuration session has timed out. more than one minute has passed
between two consecutive
configuration API calls, while
ProtecTIER is offline
2 User <VTF user> logged in from a user attempted to log in
<workstation> at <ip>.
3 Login for <VTF user> from a user login was rejected
<workstation> at <ip> has been denied.
4 Received signal <signal_num>. a signal was received
5 Stopping the ProtecTIER emulation. ProtecTIER was brought offline for
configuration purposes
6 Starting the ProtecTIER emulation. ProtecTIER was brought online
Operation started events
ID message in the event log explanation
102 ProtecTIER exiting: cleaning Y%s. ProtecTIER VT being stopped
103 Drives to ports assignment - operation front-end drive connections were
started. Library name is <lib>. configured
104 Robot to port assignment - operation a front-end robot connection was
started. Library name is <lib>. configured
105 Released shared memor segment with a shared memory
key %s (id %s).
107 Handle license violation. license violation is being handled
108 Cartridge addition - operation started. cartridges are being added to a
Library name is <lib>. library
111 Library check - operation started. Library a library is being checked
name is <lib>.
14-6 Event log messages
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ID message in the event log explanation

112 Library cleaning - operation started. a library is being cleaned
Library name is <lib>.

113 Library recovery - operation started. the database of a library is being
Library name is <lib>. recreated

115 Cartridge Format - operation started. a cartridge is being formatted to
Library name is <lib>. erase its contents

119 Check storage for orphan cartridges - lost cartridges are being identified
operation started.

120 Library creation - operation started. a new library is being installed
Library name is <lib>.

121 Cartridge move - operation started. cartridge is being moved from a
Library name is <lib> source is <loc> source element to a destination
destination is <loc>. element

122 Cartridge rebarcode - operation started. the barcode of a cartridge in an
Library name is <lib>. import-export slot is being modified

123 Changing library configuration - the number of elements of a given
operation started. Library name is <lib>. type in a given library is being

reconfigured

124 Cartridge recovery - operation started. cartridges are being recovered

Library name is <lib>.

125 Release drive - operation started. Library a drive is being released
name is <lib> logical element address is

<drive_ID>.

127 Delete library - operation started. Library a library is being deleted (all data
name is <lib>. will be lost)

128 Set cartridge WriteEnabled / the WriteDisabled/WriteEnabled
WriteDisabled attribute - operation flag of a given cartridge is being set

started. Library name is <lib> attribute
set to <write_flag>.

130 Illegal mutex nesting trying illegal mutex nesting trying
%05%s%s%s.

131 Unload drive - operation started. Library a drive is being unloaded
name is <lib> logical element address is
<drive_ID>.

132 Reset drive - operation started. Library  a drive is being reset
name is <lib> logical element address is
<drive_ID>.

Error messages 14-7
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ID message in the event log explanation
133 Reset robot - operation started. Library  a robot is being reset
name is <lib>.
196 %s starting to %s. the tape drive is starting to read or
write
197 %s finished running %s %s commands. tape drive has finished to read or
write
198 Device %s cannot accept command %s  ProtecTIER VT device rejected a
from WWN %s, %s. SCSI command
199 Device %s reserved WWN %s id %s. ProtecTIER VT device reserved
197 Device %s released WWN %os id %s. ProtecTIER VT device released
200 Device %s perform cmd %s %s %s. ProtecTIER VT device got a SCSI
command
201 Cartridge %s load into %s: %s %s. ProtecTIER VT cartridge loaded into
a virtual tape drive
202 Cartridge %s unload from %s: %s %os. ProtecTIER VT cartridge unloaded
into a virtual tape drive
Link events
ID message in the event log explanation
203 Cartridge is moved. (<status>) cartridge move event
204 Attempted recovery of failed connection switch link event
to port <port> WWN <wwn> LUN <lun>.
206 ProtecTIER port <port> got LINK_DOWN a link went down
event.
207 ProtecTIER port <port>: Got LINK_DOWN topology is being reset because the
event, setting topology to default <top>. link went down
208 ProtecTIER port <port> got LINK_UP a link came up
event.
209 ProtecTIER port <port> connected to topology is being set because a
Switch: setting topology to P2P. switch was detected
210 ProtecTIER port <port> direct connect: topology is being set because a direct
setting topology to LOOP. connection was detected
211 ProtecTIER port <port>: Link is not topology is being reset because the
ready, setting topology to default <top>. link is not ready
14-8 Event log messages
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ID message in the event log explanation

212 ProtecTIER port <port> current active current topology is being reported
topology is <top>.

213 ProtecTIER port <port> got PLOGI_RCVD PLOGI_RCVD event was received
event from WWN <wwn>.

Operation completed events

ID message in the event log explanation

401 Library creation - operation completed operation completed
<completion_code>.

402 Delete library - operation completed operation completed
<completion_code>.

403 Library recovery - operation completed operation completed
<completion_code>.

406 Library check - operation completed operation completed
<completion_code>.

407 Check storage for orphan cartridges - operation completed
operation completed <completion_code>.

408 Changing library configuration - operation completed
operation completed <completion_code>.

409 Cartridges addition - operation completed operation completed
<completion_code>.

410 Cartridge format - operation completed operation completed
<completion_code>.

411 Cartridges recovery - operation operation completed
completed <completion_code>.

412 Cartridge rebarcode - operation operation completed
completed <completion_code>.

413 Library cleaning - operation completed operation completed
<completion_code>.

414 Drives to ports assignment - operation operation completed
completed <completion_code>.

415 Robot to port assignment - operation operation completed
completed <completion_code>.

416 Unload drive - operation completed operation completed
<completion_code>.

417 Release drive - operation completed operation completed

<completion_code>.

Error messages 14-9
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explanation

operation completed

operation completed

operation completed

operation completed

explanation

ProtecTIER VT front-end got an
exception error

ProtecTIER VT front-end rejected a
SCSI command

ProtecTIER VT front-end got an
abort

ProtecTIER VT front-end, abort to
discarded command

ProtecTIER VT started
reading/writing to a cartridge data
segment

ProtecTIER VT finished
reading/writing to a cartridge data
segment

explanation

system being initialized

system being stopped

system being initialized

system being stopped

ProtecTIER

ID message in the event log

418 Reset drive - operation completed
<completion_code>.

419 Reset robot - operation completed
<completion_code>.

420 Set cartridge ReadWrite/ReadOnly -
operation completed <completion_code>.

421 Cartridge move - operation completed
<completion_code>.

Vtlu events

ID message in the event log

425 Port %s receiving, %s from WWN %bs.

426 Port %s rejecting, %s from WWN %s.

426 Port %s releasing command by xid %s on
lun %s (opcode - %s).

426 Port %s failed to release command by xid
%0s%0s%o0s.

700 Cartridge %s requesting to open %s.

701 Cartridge %s closing %bs.

Dfs events

ID message in the event log

501 Dfs construction.

502 Dfs destruction.

503 Dfs initialization.

504 Dfs termination.

14-10 Event log messages

Oracle Ex. 1226, pg. 172
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
User Guide and Reference

ID message in the event log explanation

505 %0s%s%s%os. a segment of ProtecTIER VT
cartridge has been hyperfactored
with the indicated results

506 DfsRegistration %s%s%s%bos. a segment of a ProtecTIER VT
cartridge data has been accessed

507 DfsUnregistration %s%0s%s%bos. a segment of a ProtecTIER VT
cartridge data is no longer being
accessed

508 DfsDeleteFileBegin %s%s%s%s. the deletion of a segment of a
ProtecTIER VT cartridge data has
started

509 DfsDeleteFileEnd %s%s%s%os. the deletion of a segment of a
ProtecTIER VT cartridge data has
completed

555 Library unique id is %s library name is translating library unique id to

%os. library name
556 Exit from the function ProtecTIER license violated

VtfHandleLicenseViolation - operation
completed %s.

Error messages 14-11
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ID message in the event log explanation
601 Compressor id %s - operation started, file the HyperFactor engine has started
%05%0S%0S. hyperfactoring a segment of a
ProtecTIER VT cartridge data
602 Compressor id %s - operation completed, the HyperFactor engine has finished
original size %s. hyperfactoring a segment of a
ProtecTIER VT cartridge data
603 Compressor id %s, throughput %s MB/s, information about the ProtecTIER
factoring ratio %s percent, time %s VT cartridge data segment
seconds. HyperFactor has finished factoring
604 Calculate_representation_fatal HyperFactoring of a ProtecTIER VT
%s %s %s %os. cartridge data segment failed
605 Compress_version_file_fatal HyperFactoring of a ProtecTIER VT
%s %s %s %os. cartridge data segment failed
606 Sync_algorithm_fatal HyperFactoring of a ProtecTIER VT
os %os %os %os. cartridge data segment failed
607 Index_manager_fatal HyperFactoring of a ProtecTIER VT
%s %os %s %os. cartridge data segment failed
608 Index_update_sync_fatal HyperFactoring of a ProtecTIER VT
%s %s %s %os. cartridge data segment failed
609 Reverse_index_fatal HyperFactoring of a ProtecTIER VT
%os %s %s %os. cartridge data segment failed
610 Compressor_proxy_fatal HyperFactoring of a ProtecTIER VT
%os %s %s %os. cartridge data segment failed
611 Compressor index sync mechanism gota HyperFactor is factoring a
file id to compress. ProtecTIER VT cartridge data
segment
612 Compressor index sync mechanism HyperFactor remove the reference
deletes a file. to a ProtecTIER VT cartridge data
segment
613 Vtlu event. ProtecTIER VT management event
614 Compressor index sync mechanism got an HyperFactor update aborted
abort before an update.
615 Compressor index sync mechanism slot  HyperFactor management event
management events.
14-12 Event log messages
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Error log messages

—— These messages are logged in the error log that is displayed when you
‘ Alerts 4 | click the Alerts! button on the ProtecTIER Manager display. They are
also logged in the event log.

Error messages may contain variable information. In the messages
listed below, variable information is enclosed in angle brackets.

These errors have severity = 3.
ID message in the error log explanation

50 Error: <error>. an error occurred while processing a
client request

51 The ProtecTIER emulation process could the ProtecTIER process could not be

not be found. found, but was not stopped by the
daemon
52 <message>. the driver needs to rebuild its links,
but failed to do so
53 Failed to load FE assignments for library: failed to load the library's front-end
<lib>. assignments to the configuration
54 Failed to save FE assignments for library: failed to save the library
<lib>. assignments to the database
55 System configuration database could not failed to locate system configuration
be found. database
56 System configuration database checksum system configuration database,
error. invalid checksum
57 Requesting to delete file: a segment of a cartridge’s data has
been deleted
ID message in the error log explanation

303 I/0 error on port <port> WWN <wwn> /O error
LUN <lun>.

304 Internal error (<error_ID>) in file <file> internal error
line <line>.

305 ProtecTIER port <port> memory memory allocation failure
allocation failure.

306 ProtecTIER port <port> failed to get port failed to get WWN names
WWN names.
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ID message in the error log explanation

307 ProtecTIER port <port> failed to take the port failed to take the link down
link down.

308 ProtecTIER port <port> setting topology port setting topology failed
failed.

309 ProtecTIER port <port> failed to init the port failed to initialize the link
link.

310 GA_NXT name server request failed. server request failed

311 Failed to get WWN names. failed to get WWN names

312 Failed to get link topology. failed to get link topology

313 Failed to get peer WWN names. failed to get peer WWN names

314 Failed to get name server peer ports. failed to get name server peer ports

315 Device <dev> open failed. device open failed

316 Device <dev> close failed. device close failed

317 Device <dev> not open. device is not open

318 Invalid read write flag, device <dev>. invalid read/write flag

319 Unexpected residual value on successful unexpected residual value on
response, device <dev> LUN <lun> WWN successful response
<wwn>,

320 Invalid FCP response info size, device invalid FCP response info size
<dev> LUN <lun> WWN <wwn>.

321 FCP response code error <error_code>, FCP response code error
device <dev> LUN <lun> WWN <wwn>.

322 User timeout, device <dev> LUN <lun>  user timeout
WWN <wwn>.

323 Invalid memory address, device <dev>. invalid memory address

324 Link down, device <dev> LUN <lun> link down
WWN <wwn>.

325 Problem connecting to WWN <wwn>. problem connecting to port

326 Unexpected error, device <dev> LUN unexpected error
<lun> WWN <wwn>.

327 Unexpected internal error, device <dev> unexpected internal error
LUN <lun> WWN <wwn>.

328 Device <dev> not open. device not open

329 Invalid read/write flag, device <dev>. invalid read/write flag

330 Invalid memory address, device <dev>. invalid memory address

14-14 Error log messages
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ID message in the error log explanation

331 Link down, device <dev> LUN <lun> link down
WWN <wwn>.

332 Problem connecting to WWN <wwn> problem connecting to port

333 Unexpected error, device <dev> LUN unexpected error
<lun> WWN <wwn>.

334 Unexpected internal error, device <dev> unexpected internal error
LUN <lun> WWN <wwn>.

335 Unexpected residual value on successful unexpected residual value on
response, device <dev>. successful response

336 Invalid FCP response info size, device invalid FCP response info size
<dev>.

337 FCP response code error <error_code>, FCP response code error
device <dev>.

338 User timeout, device <dev>. user timeout

339 Invalid memory address, device <dev>. invalid memory address

340 Link down, device <dev>. link down

341 Target down, device <dev>. target down

342 Unknown target, device <dev>. unknown target

343 Unexpected error, device <dev>. unexpected error

344 Unexpected internal error, device <dev>. unexpected internal error

345 Device <dev> not open. device not open

346 Invalid read/write flag, device <dev>. invalid read/write flag

347 Unexpected residual value on successful unexpected residual value on
response, device <dev> LUN <lun> WWN successful response
<wwn>.

348 Invalid FCP response info size, device invalid FCP response info size
<dev> LUN <lun> WWN <wwn>.

349 FCP response code error <error_code>, FCP response code error
device <dev> LUN <lun> WWN <wwn>.

350 User timeout, device <dev> LUN <lun> user timeout
WWN <wwn>.

351 Invalid memory address, device <dev>. invalid memory address

352 Link down, device <dev> LUN <lun> link down
WWN <wwn>.

353 Problem connecting to WWN <wwn>. problem connecting to port
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ID message in the error log explanation

354 Unexpected error, device <dev> LUN unexpected error
<lun> WWN <wwn>.

355 Unexpected internal error, device <dev> unexpected internal error
LUN <lun> WWN <wwn>.

356 Invalid memory address, device <dev>. invalid memory address

357 Received invalid argument, device <dev>. received invalid argument

358 Link down, device <dev>. link down

359 Unknown target, device <dev>. unknown target

360 Target down, device <dev>. target down

361 Unexpected error, device <dev>. unexpected error

362 Invalid memory address, device <dev>. invalid memory address

363 Received invalid argument, device <dev>. received invalid argument

364 Link down, device <dev>. link down

365 Unknown target, device <dev>. unknown target

366 Target down, device <dev>. target down

367 Unexpected error, device <dev>. unexpected error

368 Invalid memory address, device <dev>. invalid memory address

369 Received invalid argument, device <dev>. received invalid argument

370 Link down, device <dev>. link down

371 Unknown target, device <dev>. unknown target

372 Target down, device <dev>. target down

373 Unexpected error, device <dev>. unexpected error

374 Failed to get port state, device <dev>. failed to get port state

375 Failed to get port topology, device <dev>. failed to get port topology

376 Erroneous configuration file. erroneous /etc/vtl.cfg file
(<error_code>) Contents ignored!

377 Reservation conflict: requested by id reservation conflict error
<id> WWN <wwn>, held by id <id> WWN
<wwn>.

378 Illegal scsi request <req> to device illegal SCSI request error
<dev>, sense <code> (<qual>).

379 The license for this server has expired. ProtecTIER license has expired

380 The license has been violated. ProtecTIER license is in violation

14-16 Error log messages
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ID message in the error log explanation
382 Vtf internal error: %s. ProtecTIER VT internal error
383 Vtf internal file error: %s. ProtecTIER VT failed to access an
internal file
ID message in the error log explanation
423 Error on opening robot. Library name is  error opening robot
<lib>.
424 Error on opening drive <drive>. Library error opening drive
name is <lib>.
485 Compressor error dumping ring. Hyperfactor error while dumping

internal trace
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Glossary of terms |1 5

This glossary lists terms used to describe ProtecTIER.
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User terms

administrator
user

appliance

backup
application

backup server

confirmation
password

connection
properties

Technical
Support

HyperFactor

disk array

FC
FC_AL
Fibre Channel

front-end FC
port

GUI

15-2 User terms

These entries define terms that are used in the documentation and on
the displays.

Terms appearing in italics appear as glossary entries, themselves.

A user who has been assigned this role can perform all the

functions of a manager, and can also perform administration

tasks.

See ProtecTIER appliance.

The application running on the backup server. This application writes
backup data to the ProtecTIER disks as though they were tape
cartridges. Supported backup applications are listed in Release Notes.
The data center computer that runs the backup application. This

server is connected to the ProtecTIER Appliance via Fibre Channel
connections.

If you have invoked an operation, via the menu system, that could
impact adversely on the system, you are asked to confirm the action by
providing the confirmation password. If you type any other string, the
operation is not performed. The confirmation password is the word
yes.

The TCP/IP host name or IP address of the appliance, used to connect
to the appliance from the ProtecTIER Manager client.

Overland Storage’s Technical Services and Customer Support.

Diligent’s patent-pending technology for detecting recurring data and
storing single instances of it.

Disks on the disk arrays attached to the ProtecTIER Appliance are
used to store data written by the backup application running on the
backup server. Space on these disks is allocated as storage for library
configuration parameters.

Fibre Channel.
Fibre Channel arbitrated loop topology.
A serial data transfer architecture.

The Fibre Channel target port through which the backup server is
connected to the ProtecTIER Appliance.

Graphical User Interface. ProtecTIER Manager is the GUI-based
client for ProtecTIER.
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library The VTLU library appears to the backup application as a TLU, but the
storage capacity of a library is actually on disk.

LUN Logical Unit Number. ProtecTIER virtual robots and tape drives are
assigned to REO 9500D appliance front-end FC ports. Each device
receives a SCSI LUN, which uniquely identifies the device in the
context of the port.

manager user A user who has been assigned this role can perform all the
functions of the monitor user, and can also perform routine
library management operations.

monitor user A user who has been assigned this role can monitor the
activity of the appliance, its connections and its VTLU

libraries.
repository The logical representation of the physical storage connected
to ProtecTIER.
slot An internal cartridge slot or an import/export slot.
tape ProtecTIER software transparently directs sequential data to disk,

virtualization  thereby enhancing tape-based application performance, and
facilitating disaster recovery. ProtecTIER emulates tape drives and a
tape library and robotics.

TLU Tape Library Unit. A VTLU library appears to the backup application
as a TLU.
topology The Fibre Channel topology on the ports can be arbitrated loop or

switched fabric.

virtual cartridge The ProtecTIER repository is configured to contain virtual cartridges
which are treated by the backup application as real tape cartridges.

virtual device A virtual robot or virtual tape drive.

virtual robot Virtual robotic devices identify themselves as medium changer devices,
and support all the SCSI commands relevant to robots. ProtecTIER
specifically emulates the behavior of ATL P3000 tape library robotics.

virtual tape Virtual tape drives identify themselves as sequential-access devices

drive and support all the SCSI commands relevant to tape drives.
ProtecTIER specifically emulates the behavior of Quantum DLT7000
tape drives.

ProtecTIER ProtecTIER software, installed on a platform running Linux.
Appliance

ProtecTIER ProtecTIER client users can log on to one or more REO 9500D
Manager appliances from a workstation running ProtecTIER'’s client.

ProtecTIER Manager gives an overview of the configuration and data
of the appliances, and can be used to perform operations on the
libraries of the appliance and clusters.

Glossary of terms  15-3
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ProtecTIER VT A disk-based storage solution for applications running on open
systems. Using virtualization techniques, ProtecTIER VT emulates
tape library units (TLUs) and the entire tape storage and retrieval
process, to the backup application running on the backup server, when
in fact, the backup server is connected, via the REO 9500D appliance, to
disk arrays and not to physical tape drives.

VTLU Virtual Tape Library Unit. See library.
VTLU library See library.
WWN World wide name of a Fibre Channel port.

These terms are not needed to understand and use ProtecTIER. They
are needed by field personnel and might be useful if a user needs to
contact Technical Support.

back-end SCSI The SCSI (parallel SCSI, FC or iSCSI) initiator port through which

port disk arrays are connected to the REO 9500D appliance.
dtcutils A component of ProtecTTER.
HBA Host Bus Adapter. An I/O adapter situated between the host

computer's bus and the Fibre Channel loop, that manages the transfer
of information between the two channels.

SAN Storage Area Network. ProtecTIER runs on a dedicated server in the
SAN, effectively becoming a TLU-emulating SAN appliance that is
referred to as the REO 9500D appliance.

SCsI Small Computer System Interface. A parallel interface standard used
by PCs and UNIX systems for attaching peripheral devices to
computers. ProtecTIER software gives SCSI personality to each of the
virtual devices defined in a VTLU library (virtual tape drives and
virtual robotic arms).

SNMP Simple Network Management Protocol. A set of protocols for
managing complex networks. ProtecTIER provides SNMP
compatibility.

vtl_diag A component of ProtecTIER that processes the user’s commands issued

via the menu system or via ProtecTIER Manager actions.

vtfd The vtfd daemon handles ProtecTIER Manager client users logging on
to an appliance, and serves as a watch-dog for the VTL process.

15-4 User terms
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Obtaining customer support|1 6

Overland Storage Technical Support will be better able to
provide the assistance you need, if you provide all relevant
information.

Perform these diagnostic steps before you contact Technical
Support:

o Read the relevant product documentation.
o Reconstruct the events leading up to the problem.

o Run some test cases to reproduce the problem.

Providing site information. ...................... 16-2
Providing problem information. .................. 16-3
Contacting the customer support center ........... 16-4

Obtaining customer support 16-1
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Providing site information

Keep the following information available before calling Technical
Support or your customer support representative:

User and problem identification

o your company’s name and address, your name, your telephone
number and email address

o the urgency of the problem, so that it can be assigned a priority level

o for a problem that has already been reported, the problem tracking ID
and the name of your support representative, if these have been
assigned.

Software configuration

o release level of ProtecTIER that you are running
o ProtecTIER platform type
o operating system and release number

o functions of ProtecTIER that you were using when the problem arose

16-2 Providing site information
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Providing problem information

Be ready to provide the following information:

Scope of the problem

o whether or not you can reproduce the problem
o past occurrences of the problem

o whether ProtecTIER has worked correctly until now, or whether it
has been newly installed

o if ProtecTIER worked properly in the past, provide the following
information:

time period during which ProtecTIER worked properly
conditions under which ProtecTIER worked properly

changes to your system between the time ProtecTIER worked
properly and when the problem began

o sequence of events that led to the problem

Diagnostic information

o if Technical Support has instructed you to generate a problem report,
include the resulting file

o log files produced by ProtecTIER Manager, if relevant

o message numbers and complete text of any messages produced by the
system

o results of tests that you have run
o other related system output

o other information that may help solve the problem

Obtaining customer support 16-3

Oracle Ex. 1226, pg. 187
Oracle, et al. vs. Crossroads
IPR2014-01207



Diligent Technologies
ProtecTIER

Contacting the customer support center

Contact Overland Storage Technical Support in one of the following
ways to obtain assistance or to send documentation of the problem to the
Overland Storage Technical Support Center:

Mail
Overland Storage, Inc.
4820 Overland Avenue
San Diego, CA 92123
USA

Phone
US: +1 585-571-5555 or US Toll Free: +1-877-654-3429
International: +1 858-571-5555 Option 5

Technical Support is available on normal business days, 6 AM through
5 PM (PST), excluding Overland holidays. At all other times we will
respond to technical support calls within 4 hours.

Technical support for EMEA customers is available as well from our
United Kingdom office at:

+44 (0) 118-9898050
9:00 AM to 5:00 PM (GMT)
Monday through Friday

Fax
+1-858-495-4202

E-mail

technicalsupport@overlandstorage.com

16-4 Contacting the customer support center
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Website

http://www.overlandstorage.com/

Extranet

http://support.overlandstorage.com/

If you are not yet a member, click the New member? link and follow the
instructions. It’s free!

FTP site

ftp:/ftp.overlandstorage.com

Obtaining customer support 16-5
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